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 1
I n t r o d u c t i o n
This guide describes the Molecular Flow Module, an optional add-on package that 
extends the COMSOL Multiphysics® modeling environment with customized 
physics interfaces for modeling kinetic gas flows.

This chapter introduces you to the capabilities of this module. A summary of the 
physics interfaces and where you can find documentation and model examples is 
also included. The last section is a brief overview with links to each chapter in this 
guide.

In this chapter:

• About the Molecular Flow Module

• Overview of the User’s Guide
 7
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Abou t  t h e  Mo l e c u l a r  F l ow Modu l e

These topics are included in this section:

• Rarefied Gas Flows

• What Can the Molecular Flow Module Do?

• The Molecular Flow Module Physics Interface Guide

• Common Physics Interface and Feature Settings and Nodes

• Where Do I Access the Documentation and Application Libraries?

Rarefied Gas Flows

Gas rarefaction is of critical importance for both high velocity gas flows around aircraft 
traveling at high altitudes and for low velocity flows at low gas pressures, such as those 
encountered in vacuum systems. Historically most academic research has been focused 
on aerospace applications, and consequently modeling software appropriate for such 
flows is readily available. Unfortunately the techniques usually employed to model the 
high velocity flows around aircraft are inappropriate for the modeling of low velocity 
flows, such as those typically encountered in vacuum systems, since the particle-based 
methods employed produce an unacceptable level of statistical noise at low velocities.

The Molecular Flow Module is designed to offer previously unavailable simulation 
capabilities for the accurate modeling of low pressure, low velocity gas flows. The 
module facilitates accurate simulations of molecular flows in complex geometries.

What Can the Molecular Flow Module Do?

The Molecular Flow Module is a collection of tailored physics interfaces for the 
simulation of kinetic gas flows. The module includes two physics interfaces: the 
Transitional Flow interface and the Molecular Flow interface. The Transitional Flow 
interface uses a discrete velocity/lattice Boltzmann approach to solve low velocity gas 
flows in the transitional flow regime. The Molecular Flow interface uses the angular 
coefficient method to solve molecular flows.

The Physics Interfaces and Building a COMSOL Multiphysics Model in 
the COMSOL Multiphysics Reference Manual 
1 :  I N T R O D U C T I O N



The Molecular Flow Module Applications Libraries and supporting documentation 
explain how to use the physics interfaces to model a range of problems encountered 
by vacuum practitioners.

The Molecular Flow Module Physics Interface Guide

The physics interfaces in the Molecular Flow Module form a complete set of simulation 
tools, which extends the functionality of the physics interfaces of the base package for 
COMSOL Multiphysics. The details of the physics interfaces and study types for the 
Molecular Flow Module are listed in the table. The functionality of the COMSOL 
Multiphysics base package is given in the COMSOL Multiphysics Reference Manual. 

Common Physics Interface and Feature Settings and Nodes

There are several common settings and sections available for the physics interfaces and 
feature nodes. Some of these sections also have similar settings or are implemented in 

In the COMSOL Multiphysics Reference Manual:

• Studies and Solvers

• The Physics Interfaces 

• For a list of all the core physics interfaces included with a COMSOL 
Multiphysics license, see Physics Interface Guide.

PHYSICS INTERFACE ICON TAG SPACE 
DIMENSION

AVAILABLE STUDY TYPE

 Fluid Flow

 Rarefied Flow

Free Molecular Flow fmf 3D, 2D, 2D 
axisymmetric

stationary; time dependent

Transitional Flow tran 3D, 2D stationary; time dependent
A B O U T  T H E  M O L E C U L A R  F L O W  M O D U L E  |  9
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the same way no matter the physics interface or feature being used. There are also some 
physics feature nodes that display in COMSOL Multiphysics.

In each module’s documentation, only unique or extra information is included; 
standard information and procedures are centralized in the COMSOL Multiphysics 
Reference Manual.

Where Do I Access the Documentation and Application Libraries?

A number of internet resources have more information about COMSOL, including 
licensing and technical information. The electronic documentation, topic-based (or 
context-based) help, and the application libraries are all accessed through the 
COMSOL Desktop.

T H E  D O C U M E N T A T I O N  A N D  O N L I N E  H E L P

The COMSOL Multiphysics Reference Manual describes the core physics interfaces 
and functionality included with the COMSOL Multiphysics license. This book also has 
instructions about how to use COMSOL Multiphysics and how to access the 
electronic Documentation and Help content.

Opening Topic-Based Help
The Help window is useful as it is connected to the features in the COMSOL Desktop. 
To learn more about a node in the Model Builder, or a window on the Desktop, click 
to highlight a node or window, then press F1 to open the Help window, which then 

In the COMSOL Multiphysics Reference Manual see Table 2-4 for 
links to common sections and Table 2-5 to common feature nodes. 
You can also search for information: press F1 to open the Help 
window or Ctrl+F1 to open the Documentation window. 

If you are reading the documentation as a PDF file on your computer, 
the blue links do not work to open an application or content 
referenced in a different guide. However, if you are using the Help 
system in COMSOL Multiphysics, these links work to open other 
modules, application examples, and documentation sets.
 1 :  I N T R O D U C T I O N



displays information about that feature (or click a node in the Model Builder followed 
by the Help button ( ). This is called topic-based (or context) help.

Opening the Documentation Window

To open the Help window:

• In the Model Builder, Application Builder, or Physics Builder click a node or 
window and then press F1. 

• On any toolbar (for example, Home, Definitions, or Geometry), hover the 
mouse over a button (for example, Add Physics or Build All) and then 
press F1.

• From the File menu, click Help ( ).

• In the upper-right corner of the COMSOL Desktop, click the Help ( ) 
button.

To open the Help window:

• In the Model Builder or Physics Builder click a node or window and then 
press F1.

• On the main toolbar, click the Help ( ) button.

• From the main menu, select Help>Help.

To open the Documentation window:

• Press Ctrl+F1.

• From the File menu select Help>Documentation ( ).

To open the Documentation window:

• Press Ctrl+F1.

• On the main toolbar, click the Documentation ( ) button.

• From the main menu, select Help>Documentation.
A B O U T  T H E  M O L E C U L A R  F L O W  M O D U L E  |  11
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T H E  A P P L I C A T I O N  L I B R A R I E S  W I N D O W

Each model or application includes documentation with the theoretical background 
and step-by-step instructions to create a model or application. The models and 
applications are available in COMSOL Multiphysics as MPH files that you can open 
for further investigation. You can use the step-by-step instructions and the actual 
models as templates for your own modeling. In most models, SI units are used to 
describe the relevant properties, parameters, and dimensions, but other unit systems 
are available.

Once the Application Libraries window is opened, you can search by name or browse 
under a module folder name. Click to view a summary of the model or application and 
its properties, including options to open it or its associated PDF document.

Opening the Application Libraries Window
To open the Application Libraries window ( ):

C O N T A C T I N G  C O M S O L  B Y  E M A I L

For general product information, contact COMSOL at info@comsol.com.

C O M S O L  A C C E S S  A N D  T E C H N I C A L  S U P P O R T

To receive technical support from COMSOL for the COMSOL products, please 
contact your local COMSOL representative or send your questions to 

The Application Libraries Window in the COMSOL Multiphysics 
Reference Manual.

• From the Home toolbar, Windows menu, click ( ) Applications 

Libraries.

• From the File menu select Application Libraries.

To include the latest versions of model examples, from the File>Help 
menu, select ( ) Update COMSOL Application Library.

Select Application Libraries from the main File> or Windows> menus.

To include the latest versions of model examples, from the Help menu 
select ( ) Update COMSOL Application Library.
 1 :  I N T R O D U C T I O N



support@comsol.com. An automatic notification and a case number are sent to you by 
email. You can also access technical support, software updates, license information, and 
other resources by registering for a COMSOL Access account.

C O M S O L  O N L I N E  R E S O U R C E S

COMSOL website www.comsol.com

Contact COMSOL www.comsol.com/contact

COMSOL Access www.comsol.com/access

Support Center www.comsol.com/support

Product Download www.comsol.com/product-download

Product Updates www.comsol.com/support/updates

COMSOL Blog www.comsol.com/blogs

Discussion Forum www.comsol.com/community

Events www.comsol.com/events

COMSOL Video Gallery www.comsol.com/video

Support Knowledge Base www.comsol.com/support/knowledgebase
A B O U T  T H E  M O L E C U L A R  F L O W  M O D U L E  |  13
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Ove r v i ew o f  t h e  U s e r ’ s  Gu i d e

The Molecular Flow Module User’s Guide gets you started with modeling using 
COMSOL Multiphysics. The information in this guide is specific to this module. 
Instructions how to use COMSOL Multiphysics in general are included with the 
COMSOL Multiphysics Reference Manual. 

T A B L E  O F  C O N T E N T S  A N D  I N D E X

To help you navigate through this guide, see the Contents and Index.

M O D E L I N G  I N  M O L E C U L A R  F L O W

The Modeling Guidelines chapter discusses these topics: Molecular and Rarefied Gas 
Flows, Modeling Transitional Flows, and Modeling Free Molecular Flows.

R A R E F I E D  F L O W

Rarefied Flow Interfaces describes The Transitional Flow Interface and The Free 
Molecular Flow Interface including the underlying theory for the physics interfaces.

As detailed in the section Where Do I Access the Documentation and 
Application Libraries? this information can also be searched from the 
COMSOL Multiphysics software Help menu. 
 1 :  I N T R O D U C T I O N



 2
M o d e l i n g  G u i d e l i n e s
In this chapter:

• Molecular and Rarefied Gas Flows

• Modeling Transitional Flows

• Modeling Free Molecular Flows
 15
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Mo l e c u l a r  and Ra r e f i e d  Ga s  F l ow s

The Molecular Flow Module provides tools specifically designed to assist with the 
modeling of vacuum systems. Historically such tools have not been available because 
most academic research on rarefied gas flows has been focused on aerospace 
applications. Gases at low pressures cannot be modeled with conventional fluid 
dynamics tools because kinetic effects become important as the mean free path of the 
gas molecules becomes comparable to the length scale of the flow. For gases the ratio 
of the molecular mean free path to the flow geometry size is given by the Knudsen 
number (Kn=λ/l). Rarefied gas flows occur when the mean free path, λ, of the 
molecules becomes comparable with the length scale of the flow, l. There are four flow 
regimes depending on the value of the Knudsen number (Ref. 1):

• Continuum flow (Kn<0.01)

• Slip flow (0.01<Kn<0.1)

• Transitional flow (0.1<Kn<10)

• Free molecular flow (Kn>10)

These flow regimes are shown in Figure 2-1.

In the continuum flow regime the Navier-Stokes equations are applicable. Gases 
flowing in the slip flow regime show continuum behavior except in a thin layer, the 
Knudsen layer, close to the surfaces of the containing geometry. The effect of the 
Knudsen layer can be modeled using special boundary conditions for the 
Navier-Stokes equations. The Molecular Flow Module is designed to address kinetic 
gas flows (Knudsen numbers greater than 0.1) and includes the Transitional Flow and 
Free Molecular Flow interfaces, which are described in more detail next.

The Microfluidics Module includes the Slip Flow interface, which can be 
used to model gas flows at moderate Knudsen numbers, as well as a range 
of tools for modeling laminar continuum flows. 
 2 :  M O D E L I N G  G U I D E L I N E S



Figure 2-1: A plot showing the main fluid flow regimes for rarefied gas flows. Different 
regimes are separated by lines of constant Knudsen numbers. The number density of the 
gas is normalized to the number density of an ideal gas at a pressure of 1 atmosphere and 
a temperature of 0° C (n0). Equivalent pressures are shown in various units.

Continuum 
flow

Slip flow

Transitional 
flow

Free molecular 
flow
M O L E C U L A R  A N D  R A R E F I E D  G A S  F L O W S  |  17
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Mode l i n g  T r a n s i t i o n a l  F l ow s

In the transitional flow regime, the continuum approximation for the gas breaks 
down completely, and the Knudsen layer occupies a significant fraction — if not all — 
of the flow domain. Historically flows in this regime have been modeled by the direct 
simulation Monte Carlo (DSMC) method, which computes the trajectories of large 
numbers of randomized particles through the system. The discrete velocity method, 
which represents the Boltzmann equation, has also been used. The discrete velocity 
method has dependent variables that exist in six dimensions (three in real space and 
three in velocity space) by a discrete number of three-dimensional equations, each 
corresponding to a discrete velocity (the set of discrete velocities is sometimes referred 
to as the quadrature). This approach produces an increased number of degrees of 
freedom in the problem (corresponding to the number of discrete velocities used) but 
restricts the problem to only three dimensions. The velocity degrees of freedom are 
coupled together through scattering terms in the equation system. More recently the 
lattice Boltzmann technique has been shown to be an optimized form of the discrete 
velocity method (close to the continuum limit) to solve a simplified form of the 
Boltzmann equation known as the Boltzmann BGK equation. COMSOL 
Multiphysics uses a modified form of the lattice Boltzmann method to solve 
transitional flows. Unlike the DSMC method, the lattice Boltzmann method is not 
subject to statistical noise — this is an advantage for low velocity gas flows. The 
implementation available in COMSOL Multiphysics is limited to isothermal flows 
because the BGK equation has a greatly simplified scattering model with a single 
parameter: the relaxation time. The relaxation time can be chosen to produce the 
correct viscosity (the approach used in the Transitional Flow interface) or the correct 
thermal conductivity but not both simultaneously. More complicated scattering 
models (with more than one parameter) are required for nonisothermal modeling. 
Diffuse reflection of gas molecules is also assumed at all surfaces.

The Transitional Flow Interface ( ) should be used to compute fluid flows with 
Knudsen numbers greater than 0.1. Lower Knudsen number flows can be solved, but 
ultimately the problem becomes very highly coupled in the Navier-Stokes regime, and 
a fully coupled solver must be used. For three-dimensional flows and two-dimensional 
 2 :  M O D E L I N G  G U I D E L I N E S



flows with quadratures larger than the D2Q12 quadrature, it becomes impractical to 
use the fully coupled solver with the computing power that is typically available. 

Boundary Conditions

In the transitional flow regime there are no simple boundary conditions available for 
inflow and outflow. The Transitional Flow Interface includes boundary conditions that 
are applicable either in the Navier-Stokes limit (the Inlet and Outlet conditions) or in 
the molecular flow regime (for example, the Reservoir condition). If the flow 
throughout the region of interest is transitional then it is necessary to introduce 
additional domains on either side of the region of interest to allow the flow to reach a 
physical solution before it enters the region of interest. When this approach is taken 
then it is reasonable to use (with care) the boundary conditions available, even if they 
are not strictly physical. Generally it is best to use the molecular flow boundary 
conditions because they do not require the fully coupled solver.

The Wall boundary condition is valid across the full range of Knudsen numbers but is 
limited to the case of diffuse reflection of molecules incident on the boundary.

Choosing a Mesh and a Quadrature

The Transitional Flow Interface can be thought of as having a mesh in physical space 
(represented by the mesh generated by COMSOL Multiphysics) and a mesh in velocity 
space (represented by the quadrature). Accurate solutions should not vary greatly with 
the physical mesh or with the quadrature. Close to the slip flow regime, smaller 
quadratures provide a good degree of accuracy, but a finer mesh in physical space is 
required. As the flow becomes progressively more rarefied, more degrees of freedom 
are required to capture the behavior in velocity space more accurately, and 
consequently a larger quadrature is required. A coarser spatial mesh can, however, be 
employed.

For solutions to be accurate they should be both mesh and quadrature independent; 
that is, both increasing the size of the quadrature and decreasing the element size in 
the mesh should have an insignificant effect on the solution.

It is currently not possible to couple the Transitional Flow interface to the 
Molecular Flow or Laminar Flow interfaces, so transitional flows must be 
modeled in their entirety within the physics interface.
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Solving Transitional Flow Problems

Solving a stationary problem can take over 24 hours even within these constraints. For 
highly rarefied flows it can also be necessary to adjust the solver tolerances. For a 
stationary problem the default solver relative tolerance of 10−7 is reasonable for flows 
with Knudsen numbers of approximately 1. For a highly rarefied flow the solver 
tolerance might need to be tightened significantly (if the Neglect Scattering (Free 

Molecular Flow) check box is selected under Flow Properties, the relative tolerance is 
automatically changed to 10−10).

To create a probe to monitor the maximum velocity in the solution, first set up a 
Maximum coupling operator on the model domains (for example, maxop1) and add a 
Global Variable Probe for maxop1(tran.U). Then adjust the solver settings to display 
the probe output at a step taken by the solver during convergence (typically this 
requires changing the Results While Solving settings on the Segregated solver node in 
the solver sequence).

If the tolerance has been set too tight, the solver can then be stopped once the probe 
value stops changing with successive iterations. Alternatively it should also be clear if 
the tolerance needs to be further tightened, as the probe varies significantly when the 
solver stops. If this is the case it is then possible to change the solver tolerance and 
continue solving, starting from the existing solution.

To do this, in the Model Builder under the Study>Solver Configurations>Solver node, 
click Dependent Variables. In the Initial Values of Variables Solved For section, choose 
Solution from the Method list and select the solver itself in the Solution list.

Larger machines, with 10s of GB of memory, or clusters, are 
recommended for use with the Transitional Flow interface. Due to the 
large number of degrees of freedom required to solve a practical problem, 
significant memory is required, particularly in three dimensions. 

When solving a large transitional flow it is often convenient to use a probe 
to monitor a quantity that characterizes the flow. This is described next.
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For more information about probes, nonlocal couplings, and solvers, see 
these topics in the COMSOL Multiphysics Reference Manual:

• Nonlocal Couplings and Coupling Operators and Probes

• Getting Results While Solving and Studies and Solvers
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Mode l i n g  F r e e  Mo l e c u l a r  F l ow s

In the free molecular flow regime the Knudsen number is significantly greater than 
unity. The mean free path is therefore much greater than the length scale of the flow, 
and molecules collide with surfaces bounding the flow more frequently than they 
collide with one another. In this regime there are two common approaches to 
modeling the flow: the direct simulation Monte Carlo (DSMC) method (which 
computes the trajectories of large numbers of randomized particles through the 
system) and the angular coefficient method. COMSOL Multiphysics uses the angular 
coefficient method. Completely diffuse scattering (total accommodation) and 
emission are assumed at all surfaces in the geometry (in practice this is often a 
reasonable assumption for both the reflection and emission of molecules from most 
surfaces and sources). The flow is computed by integrating the flux arriving at a surface 
from all other surfaces in its line-of-sight. Because only surfaces are considered in the 
calculation, the dependent variables exist only on the surfaces of the model. This 
method is limited to quasi-static flows, in which the fluxes change on time scales that 
are large compared to the average time that the molecules take to traverse the 
geometry. It is much faster than the DSMC method and is not subject to statistical 
scatter.

The Free Molecular Flow Interface ( ) should be used to compute quasi-static 
molecular flows with Knudsen numbers greater than 10. The flux, pressure, and 
number density are solved for on all surfaces. The effect of surface temperature is also 
accounted for, and the heat flux due to the molecules themselves is available. It is also 
possible to compute the number density of gas molecules on points, lines, and even 
domains interior to the bounding surfaces of the flow.

It is very computationally expensive to compute the number density 
within the entire domain of the flow in three dimensions.

Although COMSOL Multiphysics currently does not offer a physics 
interface for Monte Carlo modeling of molecular flows, it is possible to 
use the Particle Tracing interface for limited Monte-Carlo computations 
(this requires the Particle Tracing Module). The Molecular Flow Through 
an S-Bend shows how to do this (Application Library path: 
Molecular_Flow_Module/Benchmarks/s_bend_benchmark).
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In this section:

• Boundary Conditions for Molecular Flows

• Interior Number Density Reconstruction

• Meshing

• Integration Resolution

• Results Processing

• Experimental Measurements of Number Density/Pressure

• Multiple Species

• References for the Theory of Rarefied Gas Flows

Boundary Conditions for Molecular Flows

The Free Molecular Flow Interface works by computing the incoming molecular flux 
for each species, G (always a dependent variable), at each element by integrating the 
outgoing flux, J (available as fmf.J), arriving from all boundaries within the line of 
sight. Similar integrals with different weightings on J are used to compute the number 
density, pressure, and net heat flux on the surfaces. These quantities do not normally 
affect the solution (unless, for example, the heat flux is coupled into a heat transfer 
computation that in turn effects the surface temperature). Each of the boundary 
conditions specifies the outgoing flux, J, usually in terms of the incoming flux, G.

Boundary conditions are available to describe a range of surfaces including:

• Walls (including outgassing walls, walls with adsorption and desorption, and walls 
on which deposition occurs)

• Pumps

• Incoming flux (specified directly by the user with an arbitrary expression or a 
constant value)

• Molecular effusion from a large, adjacent reservoir and total vacuum (in practice a 
large chamber with a pressure low enough that molecules entering the domain from 
the chamber can be neglected)

The Surface Temperature feature can be used to set the surface temperature on 
different surfaces if the system under consideration is nonisothermal.
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Interior Number Density Reconstruction

It is often desirable to know the number density at some point within the vacuum 
chamber (for example, along a beam line). There are two ways to compute the number 
density within a domain in COMSOL Multiphysics.

The first method is to add a Number Density Reconstruction feature to the model. 
COMSOL Multiphysics then computes the number density for each species (which is 
available as the dependent variable N) on the feature in addition to on the exterior 
surfaces of the model at the time of solving.

The Free Molecular Flow Interface also defines a number density operator, which is 
called in the following manner:

comp1.fmf.nop_name(x,y,z) (3D)
comp1.fmf.nop_name(x,y)  (2D)
comp1.fmf.nop_name(r,z)  (2D axisymmetric)

where name is the dependent variable name for a given species. The default is G, so 
comp1.fmf.nop_G(x,y,z) would be the default operator to compute the number 
density in 3D.

This operator computes the number density at the time it is called, and consequently 
if a number of computations are required (for example, for plotting the number 
density on a surface) it takes a long time to return the result (the physics interface is 
unresponsive during this time).

This method is recommended for large regions, such as surfaces and 
domains, where the calculation of the number density is computationally 
intensive, or along curved lines that are explicitly drawn within the 
geometry (such lines are more difficult to define in results processing).

If multiple components or Free Molecular Flow interfaces are added to 
the model, change comp1 and fmf to the corresponding component and 
physics interface names.

This method is recommended if the number density at a point or on a 
straight line not drawn in the geometry is required.
 2 :  M O D E L I N G  G U I D E L I N E S



Meshing

To solve molecular flow problems it is only necessary to define degrees of freedom on 
the surfaces of the flow domain. Consequently the Free Molecular Flow interface 
supports two methods for meshing:

• The entire domain selected in the Free Molecular Flow interface can be meshed.

• Exterior boundaries of the selected domain can be meshed. 

By default the Free Molecular Flow interface uses constant elements for all the degrees 
of freedom. In general, using constant elements with a fine mesh provides better 
accuracy than using higher-order elements on a coarser mesh with the same number of 
degrees of freedom. It is important to check that solutions obtained do not change 
significantly (within the desired degree of accuracy) when the mesh is further refined.

The method used by COMSOL Multiphysics to integrate the flux arriving at a 
particular mesh element can be inaccurate near interior or convex corners. If the results 
in such regions are important, it can be necessary to use a highly refined mesh and a 
high integration resolution. See Integration Resolution for further information.

Integration Resolution

The integrations performed to calculate the flux arriving at a particular element use a 
computational technique known as the hemicube method, which constructs a 2D view 
of the other elements from the perspective of each element. The resolution employed 

The number density operator and the number density reconstruction 
features produce unreliable results adjacent to the exterior surfaces of a 
Molecular Flow domain. In this region the number density on the surface 
is much more accurate.

The physics interface does not support a mixture of these two approaches, 
so, for example, volume meshing only a part of the flow domain and 
surface meshing the rest can lead to incorrect results.

COMSOL Multiphysics does not return an error message, but in some 
cases the results generated are incorrect (in a mixed approach, the method 
used to find the normals that point into the molecular flow domain can 
fail in certain circumstances).
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is determined by the Integration Settings on the Free Molecular Flow interface node. 
A larger number indicates a greater integration resolution, and consequently more 
accurate results. For the results of a model to be accurate the solution should not 
change significantly when the integration resolution is increased.

Results Processing

By default the Free Molecular Flow interface uses constant shape functions for all the 
computed quantities. Constant shape functions produce poor results with the default 
refinement method used during results processing. When constant shape functions are 
used, it is therefore recommended that the Resolution setting in the Quality section of 
most plot types is set to No Refinement.

Experimental Measurements of Number Density/Pressure

When comparing simulation results to measurements it is important to understand 
whether pressure or number density is the relevant quantity to compare. In the vacuum 
industry it is common to use the ideal gas law to relate the pressure, p, to the number 
density, n:

 (2-1)

where kB is the Boltzmann constant, and T is the absolute temperature. Equation 2-1 
is not rigorously true in a molecular flow. The derivation of the ideal gas law assumes 
that molecules arrive at a surface from random directions (at high pressure this is true 
because of collisions between the molecules). Provided highly directional effects such 
as molecular beaming are absent from a molecular flow, Equation 2-1 holds 
approximately in many circumstances (it is possible, for example, to compare the 

For 2D axisymmetric components, the number of Integration Sectors must 
also be specified. To compute the integrals in an axisymmetric component 
COMSOL Multiphysics must construct a virtual geometry in three 
dimensions. The number of sectors in the geometry are determined by 
this setting. The sensitivity of the solution to this setting should be 
evaluated.

Results Analysis and Plots in the COMSOL Multiphysics Reference 
Manual

p nkBT=
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pressure with nkBT in some of the model examples and often the two values are within 
10% of each other). A counterexample that demonstrates when this relationship 
completely fails is provided by the Rotating Plate example in the Molecular Flow 
Module’s Applications Libraries.

COMSOL Multiphysics defines pressure as the normal force acting on a surface and 
number density as the number of molecules per unit volume. Unfortunately it is 
common practice in the vacuum industry to lump both of these quantities together 
under the concept of pressure. Many vacuum gauges that operate at low pressures 
actually measure number density (in the COMSOL Multiphysics sense) but are 
calibrated to give readings in units of pressure. For these gauges it is appropriate to 
compare the quantity nkBT from a simulation with the pressure that the gauge reads.

A practicing engineer needs to answer the question: “Does my gauge actually measure 
pressure or number density?”. Ref. 2 discusses how the common types of vacuum 
gauge operate and classifies gauges as direct or indirect. Direct gauges usually measure 
the displacement of a wall, which is directly related to the pressure in a COMSOL 
Multiphysics simulation. Indirect gauges measure the “pressure” indirectly, via a gas 
property. Many indirect gauges are so-called ionization gauges, in which the gas is 
ionized by some mechanism, and the ion current generated by an electric field is 
measured. For these gauges, the quantity nkBT is appropriate for comparison with 
experimental gauge readings. Other indirect gauges operate on other principles that 
make it harder to associate them with either a pressure or a number density directly. 
For example, Pirani and thermocouple gauges measure the heat loss from a wire in the 
gas. Although this process could be modeled in detail by the Free Molecular Flow 
interface, it is often more practical to exercise engineering judgment when comparing 
simulation results with data from these types of gauges. Table 2-1 classifies common 
vacuum gauges in terms of the quantity they measure.
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Multiple Species

Since the gas molecules do not interact with each other in the flow domain, solving for 
many different species at once does not significantly increase the computational 
complexity of the problem. It is possible to model flows involving several different 
species simultaneously by adding more species in the Dependent Variables section.

Modeling multiple species is needed if adsorption and desorption of the molecules 
occurs. It is also possible for the different species to interact on the surfaces — for 
example, if they share common adsorption sites, the site occupancy can be set up as an 
expression involving the concentration of both gas molecules.

References for the Theory of Rarefied Gas Flows

1. G. Kariadakis, A. Beskok, and N. Aluru, Microflows and Nanoflows, Springer 
Science and Business Media, 2005.

2. J.F. O’Hanlon, A User’s Guide to Vacuum Technology, Wiley Interscience, 2003.

TABLE 2-1:  CLASSIFICATION OF COMMON VACUUM GAUGES BASED ON THE QUANTITY MEASURED

GAUGES THAT MEASURE 
PRESSURE p

GAUGES THAT MEASURE nkBT GAUGES THAT MEASURE 
OTHER QUANTITIES

Gauges based on the 
deflection of a solid wall:

a. Diaphragm

b. Baratron/Capacitive 
gauge

c. Bourdon gauge

Cold cathode ionization 
gauges:

a. Penning

b. Redhead

c. Magnetron

Hot cathode ionization gauges:

a. Bayard-Aplpert

b. Extractor

Radiation-based ionization 
gauges:

a. Alphatron

Gauges based on 
tangential/viscous forces:

a. Spinning rotor

Gauges based on heat 
transfer:

a. Thermocouple

b. Pirani

For an example of using multiple species in a model, see the example 
Ultrahigh Vacuum, Chemical Vapor Deposition (Application Library 
path: Molecular_Flow_Module/Industrial_Applications/uhv_cvd).
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R a r e f i e d  F l o w  I n t e r f a c e s
This chapter describes the physics interfaces available to model the flow of rarefied 
gases. These physics interfaces are found under the Fluid Flow>Rarefied Flow 
branch ( ).

• The Transitional Flow Interface

• Theory for the Transitional Flow Interface

• The Free Molecular Flow Interface

• Theory for the Free Molecular Flow Interface

See The Single-Phase Flow, Laminar Flow Interface in the COMSOL Multiphysics 
Reference Manual for other Fluid Flow interface and feature node settings.
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Th e  T r a n s i t i o n a l  F l ow I n t e r f a c e

The Transitional Flow (tran) interface ( ), found under the Rarefied Flow 
branch ( ) when adding a physics interface, can be used to model isothermal flows 
across the full range of Knudsen numbers from the laminar flow limit to the molecular 
flow limit. The method is less computationally efficient than other physics interfaces 
targeting specific Knudsen number regimes. In the transitional flow regime, at 
Knudsen numbers between 0.1 and 10, this physics interface is the available solution 
in COMSOL Multiphysics. The physics interface solves the Boltzmann BGK equation, 
which is a simplified form of the Boltzmann equation, using the lattice Boltzmann 
method. When larger lattices are used in the lattice Boltzmann method it can be 
viewed as a discrete velocity method for solving the Boltzmann BGK equation.

Diffuse reflection from all surfaces is assumed (this is reasonable in many practical 
situations) with molecules from all directions effectively adsorbed onto the surface and 
subsequently reemitted according to Knudsen’s law (that is, with an intensity that 
varies as the cosine of the angle of emission to the normal to the surface). This physics 
interface is available for 2D and 3D components.

When this physics interface is added, these default nodes are also added to the Model 

Builder: Flow Properties, Wall, and Initial Values. Then, from the Physics toolbar, add 
other nodes that implement, for example, boundary conditions and volume forces. 
You can also right-click Transitional Flow to select physics features from the context 
menu.

The physics interface solves the Boltzmann BGK equation, which is a 
simplified form of the Boltzmann equation. This provides a good 
engineering model of a rarefied gas, but it cannot be used to model 
thermal flows accurately. Currently only one species of molecule can be 
modeled. For this physics interface, the accuracy of the results obtained 
depends strongly on the quadrature employed. Accurate solutions are 
independent of both mesh density and do not change as the number of 
velocities in the quadrature is increased. It is important to validate results 
to establish if the simulation is sufficiently accurate for a given application.
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S E T T I N G S

The Label is the default physics interface name. 

The Name is used primarily as a scope prefix for variables defined by the physics 
interface. Refer to such physics interface variables in expressions using the pattern 
<name>.<variable_name>. In order to distinguish between variables belonging to 
different physics interfaces, the name string must be unique. Only letters, numbers, and 
underscores (_) are permitted in the Name field. The first character must be a letter.

The default Name (for the first physics interface in the model) is tran.

T R A N S I T I O N A L  F L O W

Select the Neglect scattering term (Molecular flow) check box to neglect scattering of the 
gas molecules within the domain. This is appropriate for models in the molecular flow 
regime.

Select an option from the Quadrature list. Several predefined quadratures are available. 
The notation for the quadratures is of the form DXQY where X and Y are integers. X 
represents the number of dimensions whilst Y represents the number of velocities in 
the quadrature. A transitional flow simulation can be considered accurate if the results 
do not change with increased Y and with reduced mesh size. This dialog defines the 
dependent variables: tran.f1...tran.fn (SI unit: 1/m3). These are defined on the 
flow properties node). There are n dependent variables defined, where n is the number 
of velocities in the quadrature.

For a practical guide to solving transitional flow models, see Modeling 
Transitional Flows. For more information on the theory of the physics 
interface, see Theory for the Transitional Flow Interface.

If the quadrature is changed after a model has been solved, the settings 
for the solver are not automatically updated. To regenerate the correct 
default solver settings, under Study, right-click the Solver Configurations 
node, select Delete Solvers and click OK. To keep the existing plot groups 
and results settings, when prompted click No. After the model is solved 
again, select the appropriate Solution node under Results>Data Sets and 
select the appropriate solver output in the Solution setting.
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Select a Form of equilibrium function — First order, Second order (the default), or Third 

order. The equilibrium function is the discretized form of the Maxwell-Boltzmann 
distribution for the gas at its local velocity and temperature.

P E R F O R M A N C E  I N D E X

To display this section, click the Show More Options button ( ) and select Advanced 

Physics Options in the Show More Options dialog box. Select the Performance index: 1, 2, 
4 (the default), 8, 16, or 32. This setting determines the number of dependent variables 
in each segregated group generated by the default solver. Select the Always use 

dependent variable grouping check box to use the segregated solver even for smaller 
quadratures in 2 dimensions.

D I S C R E T I Z A T I O N

Select the element order for the dependent variable. The default is quadratic. 

Domain and Boundary Nodes for the Transitional Flow Interface

The Transitional Flow Interface has these domain and boundary nodes available from 
the Physics ribbon toolbar (Windows users), Physics context menu (Mac or Linux 
users), or by right-clicking the main physics interface node to access the context menu 
(all users).

The Performance index setting should be selected on the basis of model 
size and available memory. Choosing a higher setting requires more 
memory to solve the model, but the model solves more quickly.

• Modeling Transitional Flows

• Domain and Boundary Nodes for the Transitional Flow Interface

• Velocity Quadratures

• Theory for the Transitional Flow Interface

• Global Equations in the COMSOL Multiphysics Reference Manual

In general, to add a node, go to the Physics toolbar, no matter what 
operating system you are using. Subnodes are available by clicking the 
parent node and selecting it from the Attributes menu.
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D O M A I N

• Flow Properties

• Initial Values

B O U N D A R Y

Across the full range of Knudsen number, Kn:

• Wall

• Continuity on Interior Boundary

In the Navier-Stokes limit (Kn<0.1):

• Inlet

• Outlet

In the Free Molecular Flow Limit (Kn>10):

• High Vacuum Pump

• Outgassing Wall

• Reservoir

• Diffuse Flux

• Total Vacuum

Although the conditions on the incident and outgoing fluxes are equivalent, the 
method for computing the incident flux and for setting the outgoing flux differs 
significantly between the two interfaces. See Theory for the Free Molecular Flow 
Interface and Theory for the Transitional Flow Interface for more detail.

On all the boundaries of the Transitional Flow interface, a number of physical variables 
are defined. These include:

• tran.G — incident flux

• tran.J — emitted flux

These boundary conditions are functionally equivalent to the Inlet and 
Outlet conditions for single-phase laminar flows (see The Single-Phase 
Flow, Laminar Flow Interface in the COMSOL Multiphysics Reference 
Manual). The mathematical form of the boundary conditions in the two 
different interfaces is, however, very different. See the Theory for the 
Transitional Flow Interface for more details.
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• tran.Nin — incident number density

• tran.Nout — emitted number density

• tran.n — total local number density (inherited from domains)

• tran.Pin — pressure due to incident molecules

• tran.Pout — pressure due to emitted molecules

• tran.p — total pressure

Flow Properties

Use the Flow Properties node to define the parameters for the Boltzmann BGK model. 
The dynamic viscosity, the temperature, and the mean molar mass must be specified. 
These parameters define the relaxation time, τ, the characteristic molecular speed, cs, 
and the molecular mass, m, which are the fundamental material parameters in the BGK 
model.

F L O W  P R O P E R T I E S

The default Dynamic viscosity μ (SI unit: Pa·s) uses the value From material. For User 

defined define a different value or expression.

The default Mean molar mass Mn (SI unit: kg/mol) is User defined with a default value 
of 0.028 kg/mol.

The pressure is not defined in the domain as a scalar because it is a tensor 
quantity for a rarefied flow. Also note that if a boundary is parallel to one 
of the lattice velocities, the sum of the incident and emitted number 
densities can differ from the total local number density due to molecules 
traveling parallel to the boundary.

A number of variables are defined in the flow properties node, enabling 
convenient analysis of the flow. These include:

• tran.ux, tran.uy, and tran.uz — velocity components

• tran.n — total number density

• tran.rho — density

• tran.lambda — mean free path
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Initial Values

The Initial Values node adds initial values for the number density, pressure, and density. 
For the transient solver, these values define the state of the problem at the initial time 
step; for the stationary solver, they serve as a starting point for the nonlinear solver.

I N I T I A L  V A L U E S

Select an option for each of the following from the Initialization list and then enter a 
value or expression in the field. Select:

• Initial number density to enter a Number density n0 (SI unit: 1/m3).

• Initial pressure to enter a Pressure p0 (SI unit: Pa).

• Initial density to enter a Density ρ0 (SI unit: kg/m3).

Wall

The Wall node sets the total incoming molecular flux, G, equal to the flux emitted from 
the wall, J. All the incident molecules are emitted diffusely, with an equilibrium 
distribution that is determined by the wall velocity and the local density.

W A L L

Select a Boundary condition: Stationary wall (the default) or Moving wall. For Moving wall 

enter a value or expression for the Wall velocity uw (SI unit: m/s).

Continuity on Interior Boundary

The Continuity on Interior Boundary node ensures continuity of the molecular flux 
across boundaries within the geometry. It is the default boundary condition for all 
interior boundaries.

Inlet

The Inlet node includes a set of boundary conditions describing the fluid flow 
condition at an inlet, in the Navier-Stokes limit.

In most cases the inlet boundary conditions appear, some of them slightly 
modified, in the Outlet type as well. This means that there is nothing in 
the mathematical formulations to prevent a fluid from leaving the domain 
through boundaries where the Inlet type is specified.
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I N L E T

Select a Boundary condition — Velocity (the default), Pressure, Density, or Number 

density. For each of the following enter a value or expression:

• For Velocity enter a Normal inflow velocity U0 (SI unit: m/s).

• For Pressure enter a Pressure p0 (SI unit: Pa).

• For Density enter a Density ρ0 (SI unit: kg/m3).

• For Number density enter a Number density n0 (SI unit: 1/m3).

Outlet

The Outlet node includes a set of boundary conditions describing the fluid flow 
condition at an outlet, in the Navier-Stokes limit.

High Vacuum Pump

Use the High Vacuum Pump node to represent a high vacuum pump such as a 
turbomolecular pump or a diffusion pump in the molecular flow regime (Knudsen 
number, Kn>10).

If the pump flux is specified directly then Jpump is user specified. Otherwise, the 
fraction of incident molecules that are pumped, f, is specified either directly or through 
a pump speed, S, such that f= √ (2πMn/RT) S/A (here Mn is the molar mass of the 
species, R is the universal gas constant, T is the temperature, and A is the area of the 
pump). This condition applies pointwise across the surface of the pump.

All of the formulations for the Outlet type are also available, possibly 
slightly modified, in Inlet type as well. This means that there is nothing in 
the mathematical formulations to prevent a fluid from entering the 
domain through boundaries where the Outlet boundary type is specified.

See Inlet for all settings.

Care should be taken with the specification of Jpump to ensure that the 
value is never negative.
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H I G H  V A C U U M  P U M P

Select an option from the Specify pump flux list: Directly (the default), Fraction of 

incident molecules (the default), or Pump speed. The emitted flux J is given by 
J = G−Jpump. 

• For Directly enter a value or expression for the Molecular flux Jpump 
(SI unit: 1/(m2·s)). The default is 0 (1/(m2·s)).

• For Fraction of incident molecules enter a value or expression for the Fraction of 

incident molecules pumped f (dimensionless). The default is 0.

• For Pump speed enter a value or expression for the Pump speed S (SI unit: m3/s). 
The default is 0 m3/s.

Diffuse Flux

The Diffuse Flux boundary condition sets the molecular flux emitted from the boundary 
to a user-specified value. This boundary condition applies only in the molecular flow 
limit (Knudsen number, Kn>10). The flux is emitted according to Knudsen’s law (the 
emitted flux in a given direction is proportional to the cosine of its angle to the surface 
normal). This can be set directly as a flux, as a total incoming mass flow, or as number 
of SCCMs. The flux is assumed to be emitted from a stationary boundary.

D I F F U S E  F L U X

Select the Boundary condition: Directly (the default), Number of SCCM units, Mass flux, or 
Total mass flow.

Directly
For Directly enter a value or expression for the Molecular flux Jo (SI unit: 1/(m2·s)). 
The default is 0 (1/(m2·s)).

Number of SCCM (standard cubic centimeters per minute) Units
For Number of SCCM units enter the Number of SCCM units Qsccm (dimensionless), and 
this quantity is automatically converted to a standardized volumetric flow rate in SI 
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units. Select an option from the Standard flow rate defined by list — Standard density 
(the default) or Standard pressure and temperature.

• For Standard density enter a Standard molar volume Vm (SI unit: m3/mol). The 
default is 0.0224136 m3/mol. 

• For Standard pressure and temperature enter a Standard pressure Pst (SI unit: Pa) and 
Standard temperature Tst (SI unit: K). The defaults are 1 atm and 273.15 K, 
respectively.

Mass Flux
For Mass flux enter a value or expression for the Mass flux Mf (SI unit: kg/(m2·s)).

Total Mass Flow
For Total mass flow enter a value or expression for the Total mass flow Qm (SI unit: 
kg/s).

Total Vacuum

In the molecular flow limit (Knudsen number, Kn>10), use the Total Vacuum boundary 
condition to set the flux emitted from the wall, J, equal to zero. This is equivalent to 
an opening to a large vessel or extended region with a much lower pressure than that 
in the system.

Reservoir

The Reservoir boundary condition is appropriate in the molecular flow limit (Knudsen 
number, Kn>10) when a boundary represents a stationary opening to a large adjacent 
vessel or region filled with gas at a specified number density or pressure. In this case 
the effusing flux obeys Knudsen’s law.

R E S E R V O I R

Select the Boundary condition: Reservoir pressure (the default) or Reservoir number 

density.

• For Reservoir pressure enter a value or expression for the Reservoir pressure p0 (SI 
unit: Pa).

For 2D components, also enter a Channel thickness dbc (SI unit: m).
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• For Reservoir number density enter the Reservoir number density n0 (SI unit: 
1/(m3)).

Outgassing Wall

In the molecular flow limit (Knudsen number, Kn>10), use the Outgassing Wall 
boundary condition to represent a wall or surface that is outgassing at a specified rate 
in addition to re-emitting incident molecules diffusely. In this case the emitted 
molecular flux, J, is given by J = G+Jout, where Jout is the user-specified outgassing 
flux. Jout can be specified as a molecular flux, a mass flux, a number of SCCM units, 
or a total mass flow. The wall is assumed to be stationary.

O U T G A S S I N G  W A L L

Select the Boundary condition: Directly (the default), Number of SCCM units, Mass flux, or 
Total mass flow.

The reservoir boundary condition represents an opening to an adjacent 
chamber whose extent is much larger than the molecular mean free path. 
The boundary condition assumes that the molecules in the reservoir have 
a Maxwellian distribution of velocities and that the size of the opening to 
the reservoir is much less than the mean free path. Molecules travel 
through the opening by a process known as molecular effusion. Effusion 
is a process that selects molecules with higher molecular speeds than 
average because they are traveling toward the hole faster than the other 
molecules. Effusing molecules therefore have a larger average velocity 
than the molecules in the adjacent reservoir. As a result the pressure or 
number density at the reservoir boundary can differ from the value set in 
the boundary condition — which determines the pressure that would be 
measured within the reservoir away from the opening.

The rest of the settings are the same as for the Diffuse Flux node.
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Th eo r y  f o r  t h e  T r a n s i t i o n a l  F l ow 
I n t e r f a c e

The Transitional Flow Interface theory is described in this section:

• Overview of the Lattice Boltzmann Method

• Relaxation Time and Mean Free Path

• About the Boundary Conditions for Transitional Flow

• Velocity Quadratures

• References for the Transitional Flow Interface

Overview of the Lattice Boltzmann Method

The Transitional Flow Interface uses the lattice Boltzmann method to solve the 
Boltzmann BGK equation, which is a simplified form of the more general Boltzmann 
equation. The BGK equation (in the absence of volume forces) is given below:

where ξ is the particle velocity, x is the position, t is the time, f(ξ ,x ,t) is the 
distribution function (which represents the total number of particles in the phase space 
dξdx), feq is the local equilibrium distribution, n is the number density, u is the bulk 
velocity, and τ is the relaxation time. This equation is similar to the Boltzmann 
equation, except the complex collision term has been replaced by a much simpler term 
that implies a constant relaxation time for all velocities to return to equilibrium. The 
equilibrium function in N dimensions is given by:

 (3-1)

The equation set is still nonlinear as feq(ξ ,u ,ρ) is a nonlinear function of f(ξ ,x ,t) (see 
definitions of n and u). As in the Boltzmann equation, the macroscopic 
thermodynamic variables are defined as moment integrals of the distribution function. 
For example, the number density and fluid velocity are given by:

t∂
∂ f ξ x t, ,( ) ξ f∇⋅ ξ x t, ,( )+

f ξ x t, ,( ) feq ξ u n,( , )–
τ

------------------------------------------------------–=

feq ξ u n,( , ) n m
2πkBT
------------------ 
 N 2⁄ m ξ u–

2

kBT
------------------------–

 
 
 

exp=
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where m is the molecular mass.

In the lattice Boltzmann approach, the BGK equation is projected onto a finite velocity 
quadrature. In this case each velocity direction in the lattice has an associated 
distribution function, which can be interpreted as the local number density of the gas 
moving with the velocity specified. Weights associated with each of the velocities are 
used when calculating the moments of the distribution functions, such as the 
macroscopic density and velocity. When the lattice used is larger than that required to 
solve the Navier-Stokes equations, the lattice Boltzmann method is effectively an 
optimized discrete velocity method for solving the BGK equation

The Boltzmann Equations become:

 (3-2)

where there are now i distribution functions, fi, associated with each of the discrete 
velocity directions, ξi, and each having an associated equilibrium function, . The 
number density and velocity become:

The velocity lattice and equilibrium functions used are critical in determining the 
accuracy of the final solution. The approach used to generate the equilibrium functions 
and velocity lattice used by COMSOL Multiphysics is described in detail in Ref. 1. The 
distribution function f(ξ ,x ,t) is expanded in the Hermite polynomials. The velocity 
space is approximated by a Gauss-Hermite quadrature. This approach is closely related 
to Grad’s moment scheme for solving the Boltzmann equation (Ref. 2). The Hermite 
polynomials are chosen because the lower-order velocity moments of the distribution 

n x t,( ) f ξ x t, ,( ) ξd
v
=

u x t,( ) 1
n x t,( )
----------------- ξf ξ x t, ,( ) ξd

v
=

t∂
∂ fi x t,( ) ξi fi∇⋅ x t,( )+

fi x t,( ) fi
eq ξ u ρ,( , )–

τ
--------------------------------------------------–=

fi
eq

n x t,( ) fi x t,( )
i
=

u x t,( ) 1
n x t,( )
----------------- ξifi x t,( )

i
=
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functions depend only on the lower-order coefficients of the Hermite polynomials, so 
that truncating the expansion has a minimal effect on the moments themselves.

The  functions are derived by expanding the drifting Maxwellian distribution in the 
Hermite polynomials to a given order. Using Equation 3-1 and the orthogonality and 
completeness of the Hermite basis this equation results:

where neq is the equilibrium number density (usually the local number density), ueq is 
the equilibrium velocity (usually the local velocity), and H(n)(ξ) is the nth 
N-dimensional Hermite polynomial, given by:

with:

The expansion for the isothermal case, evaluated in the Gauss-Hermite quadrature, is 
given below, with terms according to progressively higher orders of approximation 
indicated (Ref. 1):

 (3-3)

here wi is the weight associated with the velocity quadrature and cs is the characteristic 
speed, which in the BGK model is given by:

fi
eq

fi
eq 1

n!
-----an

eq x t,( )H n( ) ξ( )

n 0=

∞

=

an
eq x t,( ) neq

m
2πkT
--------------- 
 N 2⁄ m ξ ueq–

2

kBT
-----------------------------–

 
 
 

exp H n( ) ξ( ) ξd

ξ
=

H n( ) ξ( ) 1–( )n

w ξ( )
--------------∇nw ξ( )=

w ξ( ) 1

2π( )N 2⁄
--------------------- ξ ξ⋅

2cs
2

----------–
 
 
 

exp=

                     First order       Second order

fi
eq ξ u ρ,( , ) neqwi 1

ξi ueq⋅

cs
2

------------------+
ξi ueq⋅ 2

2cs
4

---------------------
ueq

2

2cs
2

---------–+





=

 
ξi ueq⋅

6cs
2

------------------
ξi ueq⋅( )2

cs
4

--------------------------
3ueq

2

2cs
2

------------–
 
 
 

+





    Third order

           

            
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The higher-order terms are typically significant only at higher Mach numbers. While 
rarefied flows can be simulated with second-order or even first-order equilibrium 
functions, a set of distribution functions up to third order are provided for 
completeness.

It is important to realize that highly accurate solutions of the Boltzmann equation are 
difficult to obtain in the transitional region. The accuracy of the Transitional Flow 
interface is strongly dependent on the number of lattice directions in the quadrature, 
and in general it is best to use the largest number possible within hardware and time 
constraints. You can assess the level of accuracy of the simulation by comparing the 
results obtained with solutions produced by the Free Molecular Flow interface in the 
molecular flow limit. The Transitional Flow interface also solves flows in the slip flow 
and molecular flow limits, which can be used for benchmarking.

Relaxation Time and Mean Free Path

The relation between the scattering time, τ, and the more familiar mean free path, λ, 
is nontrivial in general. For molecules traveling at a specific lattice velocity, ξ i, the 
mean free path can be defined as:

The Transitional Flow interface includes a mean free path variable defined as the 
velocity space average of the mean free path. This is given by:

cs
kBT
m
-----------=

The equations used in the Transitional Flow interface include terms that 
are temperature dependent. However, the Boltzmann BGK model 
restricts the Prandtl number of the gas to be a fixed (unphysical) value and 
therefore cannot be used to treat nonisothermal flows correctly. This 
physics interface is therefore restricted to the treatment of isothermal 
flows, although the temperature must be entered in the Flow Properties 
node.

λi ξi τ=
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This variable can differ from kinetic theory definitions of the mean free path based on 
the viscosity and number density, due to the approximations inherent in representing 
the velocity space by the quadrature.

About the Boundary Conditions for Transitional Flow 

Boundary conditions in the Transitional Flow interface are kinetically motivated and 
assume the diffuse reflection or emission of molecules from surfaces. Molecules can be 
emitted from surfaces with a drifting or nondrifting velocity distribution, which 
enables a range of boundary conditions to be formulated. In the Navier-Stokes limit, 
the emission of molecules from a surface with a drifting Maxwellian enables pressure 
and velocity boundary conditions to be formulated. In the molecular flow limit a range 
of boundary conditions based on the diffuse emission of molecules from stationary 
walls are available. The Wall boundary condition itself is valid across the full range of 
Knudsen numbers. When constructing models the validity of the boundary conditions 
must be carefully considered.

The diffuse reflection boundary condition was first derived for the lattice Boltzmann 
method (which is used by the Transitional Flow interface) by Ansumali and Karlin 
(Ref. 3). COMSOL Multiphysics uses a slightly modified version of this boundary 
condition, for consistency with the Free Molecular Flow interface. In Ref. 3 a detailed 
formal derivation of the boundary condition is given, based on general kinetic theory 
arguments. Here, the boundary condition is derived using the assumption of 
Knudsen’s law for the emission of molecules from the boundary.

To account for the motion of the wall (at velocity uw), consider the distribution 
functions in a moving frame, such that the wall is stationary. In this case the continuum 
velocity distribution function, f(ξ ,x,t), can be written as g(χ ,x,t), where χ = ξ – uw. 
Knudsen’s law states that the emitted flux of molecules, J(χ ,x,t), is related to the 
equilibrium distribution by (Ref. 5):

 (3-4)

where α is a normalization constant, and geq(χ ,0,ρ) is given by Equation 3-1. α is 
determined by setting the total outgoing flux, J, to a fixed value, giving:

λ

ξi τfi

i


fi

i


----------------------=

J χ x t, ,( ) α χ n⋅–( )geq χ 0 ρ, ,( )=
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 (3-5)

For a wall boundary condition, the total outgoing flux is usually equated to the total 
incoming flux, G, given by:

 (3-6)

The symbol χ’ is used to represent velocity vectors in the incoming half of velocity 
space. The fluxes J(χ ,x ,t) and G(χ’ ,x ,t) can be written in terms of the distribution 
function by considering that the rate of molecules arriving at the surface is related to 
the normal velocity component of the molecules traveling at velocity χ, as well as the 
number density of these molecules:

 (3-7)

Assuming J = G and substituting Equations 3-5, 3-6, and 3-7 into Equation 3-4 gives 
the result:

 (3-8)

The asterisk indicates that the variable g* refers to only the outgoing velocity 
distribution function. Considering the form of geq(χ ,0 ,ρ) from Equation 3-1 it is 
clear that the equilibrium function is completely symmetric about the origin, so the 
following result applies:

Equation 3-8 is therefore equivalent to the result derived in Ref. 3 (note that the 
COMSOL Multiphysics convention of n represents the outward normal of the 
domain, whilst in Ref. 3 n is defined as the inward normal).

α J

χ n⋅–( )geq χ 0 ρ, ,( ) χd

χ n⋅ 0<


----------------------------------------------------------------------------=

G G χ' x t, ,( ) χ'd

χ' n⋅ 0>
=

J χ x t, ,( ) χ n⋅–( )g χ x t, ,( )= χ n⋅ 0<( )
G χ' x t, ,( ) χ' n⋅( )g χ' x t, ,( )= χ' n⋅ 0>( )

g∗ χ x t, ,( )

χ' n⋅( )g χ′ x t, ,( ) χ'd

χ' n⋅ 0>


χ n⋅–( )geq χ 0 ρ, ,( ) χd

χ n⋅ 0<


----------------------------------------------------------------------------geq χ 0 ρ, ,( )= χ n⋅ 0<

χ n⋅–( )geq χ′ 0 ρ, ,( ) χd

χ n⋅ 0<
 χ′ n⋅ geq χ′ 0 ρ, ,( ) χd

χ′ n⋅ 0>
=
T H E O R Y  F O R  T H E  T R A N S I T I O N A L  F L O W  I N T E R F A C E  |  45



46 |  C H A P T E R
Considering Equation 3-1 again, it is clear that geq(χ ,0 ,ρ) = feq(ξ ,u, ρ) so 
Equation 3-5 can be transformed back to the stationary reference frame in the 
following manner:

Similarly Equation 3-6 becomes:

The boundary condition can be straightforwardly converted to the discretized velocity 
set used in the Transitional Flow interface:

 (3-9)

 (3-10)

The validity of the discretization form was proved by Ansumali and Karlin (Ref. 3). 

Equation 3-9 and Equation 3-10 form the basis of all the boundary conditions used in 
the Transitional Flow interface. For wall boundary conditions at all Knudsen numbers 
the relation J = G is used to define the boundary condition. In the molecular flow limit 
J is usually defined on the basis of kinetic theory expressions for the effusive molecular 
flux, with uw = 0. In the Navier-Stokes limit a fluid velocity boundary condition can 

f∗ ξ x t, ,( ) J

ξ uw–( )– n⋅( )feq ξ uw ρ Tw, , ,( ) ξd

ξ uw–( ) n⋅ 0<


-------------------------------------------------------------------------------------------------------------------------feq ξ uw ρ, ,( )=

                                                          ξ uw–( ) n⋅ 0<

G ξ' uw–( ) n⋅( )f ξ′ x t, ,( ) ξ'd

ξ' uw–( ) n⋅ 0>
=

fi∗
J

ξ uw–( )– n⋅( )fi
eq

ξ uw–( ) n⋅ 0<


-------------------------------------------------------------------------------fi
eq

= ξ uw–( ) n⋅ 0<

G ξi uw–( ) n⋅( )fi

ξi uw–( ) n⋅ 0>
=

The outgoing number densities in Equation 3-9 contain fi
eq terms in 

both the numerator and the denominator. Inspection of Equation 3-3 
shows that all these terms are premultiplied by the equilibrium number 
density, neq. In COMSOL Multiphysics, these number density factors are 
left out of the equilibrium functions, except where they are specifically 
required, which results in considerable performance improvements for 
the physics interface.
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be implemented by setting uw = ufluid and J = G (ufluid is the user-defined fluid 
velocity). The pressure boundary condition in the Navier-Stokes limit is more 
complex, and is described next.

P R E S S U R E  B O U N D A R Y  C O N D I T I O N  F O R  N A V I E R - S T O K E S  L I M I T

Specifying a pressure in the fluid in the Navier-Stokes limit is in general difficult with 
a kinetic equation. In the molecular flow limit the kinetic theory expressions for the 
flux due to molecular effusion from a reservoir at constant pressure can be employed. 
In this case the flux enters the domain with a stationary Maxwellian. In the 
Navier-Stokes limit the incoming flux is harder to specify because the molecules 
entering the domain do so with a Maxwellian that is drifting at the velocity of the fluid. 
Pressure boundary conditions based on solutions of the Boltzmann equation within 
Grad’s 13 moment system have been developed (Ref. 2 and Ref. 6), but these are 
complex. A simpler approach is used in the Transitional Flow interface, which produces 
good results when compared with Navier-Stokes fluid flow benchmarks.

In Equation 3-9 there are two unknowns: the emitted flux and the velocity of the 
Maxwellian. To make the incoming molecules enter with a velocity distribution 
determined by the fluid flow in the Navier-Stokes limit, uw = u is set, where u is the 
local fluid velocity (a function of both the outgoing and incoming distribution 
functions; note that at this stage the outgoing distribution functions are not 
determined). The amount of gas entering the fluid flow domain is not straightforward 
to determine, but it is possible to adjust the flux entering the domain continuously to 
ensure that the pressure remains constant. In COMSOL Multiphysics this is done by 
means of a weak form equation for the emitted flux, defined on the boundary. This 
approach ensures that the pressure is fixed on the boundary whilst allowing the velocity 
to be determined by the overall fluid flow. This is the desired behavior for a pressure 
boundary condition in the Navier-Stokes limit. Note that for converged solutions it is 
observed that the computed emitted flux is equal to the incoming flux, which justifies 
the use of the moving wall boundary condition in this manner.

Velocity Quadratures

The velocity quadrature used in a simulation is a critical factor to determine the 
accuracy of the results obtained. With the form of the equilibrium function defined 
above, it is necessary to use a Gauss-Hermite quadrature for the velocity lattice, with 
the appropriate basis function. This guarantees that summing over the velocity basis, 
to compute quantities such as the density, results in the most accurate value for the 
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quantity of interest when compared to an integral over the continuum velocity space 
(which is what the lattice Boltzmann method approximates).

COMSOL Multiphysics uses velocity quadratures based on the formalism described in 
Ref. 1. Consider first the generation of a one-dimensional quadrature. The pth order 
Hermite polynomial is generated from the function w(ξ)=exp(-ξ2/2)/√(2π) by the 
equation:

To generate a one-dimensional quadrature of order p, the roots of the equation 
H(p)(ξ)=0 need to be evaluated. These roots represent the velocity coordinates of the 
quadrature. The pth order polynomial, H(p)(ξ), has p roots: ξq, where q=1...p. To 
compute the weights associated with the quadrature the following formula is used:

Two-dimensional and three-dimensional quadratures can be generated from a 
one-dimensional quadrature through the product rule. The product rule constructs a 
two-dimensional quadrature by placing the one-dimensional quadrature along both 
the x and y axes and generating a grid that passes through all the points on the axes. 
The points at the intersection of the grid lines represent the velocity coordinates of the 
two-dimensional quadrature. The weights corresponding to each velocity coordinate 
are also multiplied together. Three-dimensional quadratures are generated in an 
analogous manner.

The following quadratures have been generated as described above using the product 
rule: D2Q9, D2Q16, D2Q25, D2Q36, D2Q64, D2Q100, D3Q27, D3Q64, 
D3Q216, and D3Q512. COMSOL Multiphysics also includes some lower-order 
quadratures that are not generated directly from the product rule. These are listed in 
Table 3-1.

H p( ) ξ( ) 1–( )p

w ξ( )
--------------

ξp

p

d

d w ξ( )( )=

wq
p!

pH p 1–( ) ξq( )( )
2

-----------------------------------------=

A correct transitional flow solution should be independent of the 
quadrature when the number of velocity directions is increased. It is 
therefore necessary to demonstrate that solutions are both quadrature and 
mesh independent as part of the validation procedure.
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TABLE 3-1:  TWO-DIMENSIONAL VELOCITY LATTICES AVAILABLE IN THE TRANSITIONAL FLOW INTERFACE

QUADRATURE w NOTES

D2Q12

D2Q12

(continued)

D2Q12

(continued)

Note that ξa is the velocity associated with the given lattice point (cs is the characteristic speed) whilst
w is the corresponding weight.

ξi cs⁄

6 nπ
2
------- 
 cos nπ

2
------- 
 sin( , )

1 36⁄ n 0 1 2 3, , ,=
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4
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4
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45
--------------------
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2

--------------------=

s mπ
4
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4
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45
--------------------

m 1 3 5 7, , ,=
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Th e  F r e e  Mo l e c u l a r  F l ow I n t e r f a c e

In the free molecular flow regime, the mean free path of a gas is larger than the 
dimensions of the object being considered. Equivalently the Knudsen number is much 
greater than 1. Gas molecules therefore interact with surfaces more frequently than 
they interact with one another and the flow of gas is determined by collisions with the 
surfaces in the system.

The Free Molecular Flow (fmf) interface ( ), found under the Rarefied Flow 
branch ( ) is intended for molecular flows interacting with objects that are moving 
slowly with respect to the speed of the molecules, such as vacuum systems. Diffuse 
reflection from all surfaces is assumed (this is reasonable in the majority of practical 
situations) with molecules from all directions effectively adsorbed onto the surface and 
subsequently reemitted according to Knudsen’s law (that is, with an intensity that 
varies as the cosine of the angle of emission to the normal to the surface).

When this physics interface is added, these default nodes are also added to the Model 

Builder: Molecular Flow, Wall, and Initial Values. Then, from the Physics toolbar, add 
other nodes that implement, for example, boundary conditions and volume forces. 
You can also right-click Free Molecular Flow to add physics from the context menu.

S E T T I N G S

The Label is the default physics interface name. 

The Name is used primarily as a scope prefix for variables defined by the physics 
interface. Refer to such physics interface variables in expressions using the pattern 
<name>.<variable_name>. In order to distinguish between variables belonging to 
different physics interfaces, the name string must be unique. Only letters, numbers, and 
underscores (_) are permitted in the Name field. The first character must be a letter.

The default Name (for the first physics interface in the model) is fmf.

For this physics interface the transient solver computes a quasi-static flow. 
The assumption is made that all fluxes in the model change much more 
slowly than the transit time of the molecules across the geometry. At every 
time step the solver assumes that flux emitted from a source boundary 
arrives instantaneously at a destination boundary.
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I N T E G R A T I O N  S E T T I N G S

Select an Integration method — Hemicube (the default) or Direct area integration. These 
methods define how the incoming molecular flux, G, is computed at each element.

Hemicube
Hemicube is the default. The more sophisticated and general hemicube method uses 
a z-buffered projection on the sides of a hemicube (with generalizations to 2D and 
1D) to account for shadowing effects. Think of it as rendering digital images of the 
geometry in five different directions (in 3D; in 2D only three directions are needed), 
and counting the pixels in each mesh element to evaluate its view factor.

Its accuracy can be influenced by setting the integration resolution of the virtual 
snapshots. The number of z-buffer pixels on each side of the 3D hemicube equals the 
specified resolution squared. Thus the time required to evaluate the flux increases 
quadratically with resolution. In 2D, the number of z-buffer pixels is proportional to 
the resolution property, and thus the time is, as well.

For an axisymmetric geometry, Gm and Famb must be evaluated in a corresponding 
3D geometry obtained by revolving the 2D boundaries about the axis. COMSOL 
creates this virtual 3D geometry by revolving the 2D boundary mesh into a 3D mesh. 
You can control the resolution in the azimuthal direction by setting the number of 
azimuthal sectors, which is the same as the number of elements to a full revolution. Try 
to balance this number against the mesh resolution in the rz-plane.

Direct Area Integration

COMSOL Multiphysics evaluates the integrals directly, without considering which 
face elements are obstructed by others. This means that shadowing effects (that is, 
surface elements being obstructed in nonconvex cases) are not taken into account. 
Elements facing away from each other are, however, excluded from the integrals.

You can control the accuracy by specifying an integration order. Sharp angles and small 
gaps between surfaces can require a higher integration order for accuracy but also more 
time to evaluate the flux.

Direct area integration is fast and accurate for simple geometries with no 
shadowing, but such circumstances rarely apply for free molecular flows. 
This setting is not recommended.
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• For Hemicube select an Integration resolution — 256 is the default.

• For Direct area integration select an Integration order — 4 is the default.

C O M P U T E

In order to solve a free molecular flow it is always necessary to solve for the incident 
molecular flux, G for each species. The Pressure, Number density, and Heat flux on the 
surfaces can be optionally computed by performing additional integrations. The 
Pressure and Number density are computed by default. 

D E P E N D E N T  V A R I A B L E S

Enter the Number of species. The default is 1, but it is possible to add more. It is often 
convenient to rename the species to something more descriptive for cases when 
multiple species exist, for example, H2 or SiH4.

The Incident molecular fluxes G (SI unit: 1/(m2s)) dependent variable is always solved 
for. It represents the incoming flux at the surface (the outgoing flux is available as 
fmf.J). Other dependent variables might not be solved for, depending on the settings 
in the Compute section (see above). 

• The Pressure p (SI unit: Pa) represents the total normal force acting on the surface 
per unit area (including contributions from both incoming and outgoing 
molecules). 

For 2D axisymmetric components, also select the Integration sectors. To 
compute the integrals in an axisymmetric component COMSOL 
Multiphysics must construct a virtual geometry in 3 dimensions. The 
number of sectors in this geometry is determined by this setting.

Integrating the flux over geometries that involve sharp angles or small 
gaps is difficult and requires a higher integration resolution and more 
refined elements than similar geometries without these features. In these 
situations large areas of the surface are present in regions that correspond 
to a small solid angle, effectively exaggerating errors caused by the 
pixelation of the geometry. If these physics are not critical to the model it 
is best practice to remove them by, for example, adding a chamfer to an 
acute edge.
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• The Number density n (SI unit: 1/(m3)), gives the total number density in the 
vicinity of the surface. 

• The Outward heat flux Q (SI unit: W/m2) is the heat flux out of the Free Molecular 
Flow domain as a result of heat adsorbed by the wall as it interacts with the gas.

For each of the dependent variables, the name can be changed in the corresponding 
field, but the name of fields and dependent variables must be unique within a model.

D I S C R E T I Z A T I O N

Select the element order for the dependent variable. The default is constant, meaning 
the molecular flux, pressure and number density will be constant within each mesh 
element. 

In the COMSOL Multiphysics Reference Manual see Table 2-4 for links 
to common sections and Table 2-5 to common feature nodes. You can 
also search for information: press F1 to open the Help window or Ctrl+F1 
to open the Documentation window.

• Domain, Boundary, Edge, Point, and Pair Nodes for the Free 
Molecular Flow Interface

• Theory for the Free Molecular Flow Interface

The following models are found at this Application Library path: 
Molecular_Flow_Module/Industrial_Applications/

• Adsorption and Desorption of Water in a Load Lock Vacuum System: 
application name: water_adsorption_desorption

• Differential Pumping: application name: differential_pumping

• Evaporator: application name: evaporator

• Molecular Flow in an Ion-Implant Vacuum System: application 
name: ion_implanter

• Ultrahigh Vacuum, Chemical Vapor Deposition: application name: 
uhv_cvd
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Domain, Boundary, Edge, Point, and Pair Nodes for the Free 
Molecular Flow Interface

The Free Molecular Flow Interface has these domain, boundary, edge, point, and pair 
nodes, listed in alphabetical order, available from the Physics ribbon toolbar (Windows 
users), Physics context menu (Mac or Linux users), or right-click to access the context 
menu (all users).

The following models are found at this Application Library path: 
Molecular_Flow_Module/Benchmarks/

• Molecular Flow Through an S-Bend: application name: 
s_bend_benchmark

• Molecular Flow Through a Microcapillary: application name: 
vacuum_capillary

• Molecular Flow Through an RF Coupler: application name: rf_coupler

• Outgassing Pipes: application name: outgassing_pipes

• Rotating Plate in a Unidirectional Molecular Flow: application 
name: rotating_plate

In general, to add a node, go to the Physics toolbar, no matter what 
operating system you are using. Subnodes are available by clicking the 
parent node and selecting it from the Attributes menu.

• Diffuse Flux

• Evaporation

• Initial Values

• Molecular Flow

• Number Density Reconstruction

• Reservoir

• Surface Temperature

• Total Vacuum

• Vacuum Pump

• Wall

• Plane Symmetry

For 2D axisymmetric components, COMSOL Multiphysics takes the axial 
symmetry boundaries (at r = 0) into account and automatically adds an 
Axial Symmetry node to boundaries that represent the symmetry axis.
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Number Density Reconstruction

Use the Number Density Reconstruction node to compute the number density on 
interior domains, boundaries, edges, or points at the time of solving the model.

Molecular Flow

Use the Molecular Flow node to define the mean molar mass. This is required to 
compute the pressure, number density, and heat flux at the boundaries.

M O L E C U L A R  F L O W

By default the Mean molar mass Mn, G (SI unit: kg/mol) is User defined. For each 
species, enter a value or expression in the field. The default is 0.028 kg/mol.

Surface Temperature

Use the Surface Temperature node to define the surface temperature at the boundary. 
For nonisothermal models, additional Surface Temperature features can be added to 
the model to define different temperatures on different surfaces. The temperature can 

In the COMSOL Multiphysics Reference Manual see Table 2-4 for links 
to common sections and Table 2-5 to common feature nodes. You can 
also search for information: press F1 to open the Help window or Ctrl+F1 
to open the Documentation window.

In addition to the Number Density Reconstruction features the Free 
Molecular Flow interface also includes an operator that can be used in 
postprocessing or in the absence of geometry elements to select. The 
number density operator is called in the following manner:

comp1.fmf.nop_name(x,y,z) (3D)
comp1.fmf.nop_name(x,y)  (2D)
comp1.fmf.nop_name(r,z)  (2D axisymmetric)

where name is the dependent variable name for a given species. The 
default is G, so comp1.fmf.nop_G(x,y,z) would be the default operator 
to compute the number density in 3D. If there are multiple components 
or Free Molecular Flow interfaces in the model, change the component 
name comp1 and physics interface name fmf accordingly.
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also be computed by a second coupled physics interface (for example, a Heat Transfer 
in Solids interface).

S U R F A C E  T E M P E R A T U R E

By default the Temperature T (SI unit: K) is User defined. The default is 293.15 K. If 
additional physics interfaces (such as a Heat Transfer in Solids interface) are available 
which compute the temperature, the output of these physics interfaces can be selected.

Evaporation

Use the Evaporation node to define an evaporative source. This feature is usually used 
in combination with a Surface Temperature node, which sets the temperature of the 
source.

E V A P O R A T I O N

For each species, enter a Vapor pressure pvap, G (SI unit: Pa) for the evaporating 
material. The default is 0 Pa.

For each species, enter an Evaporation coefficient av, G (dimensionless) for the 
evaporating material. The default is 1.

Initial Values

The Initial Values node adds initial values for the incident molecular flux, number 
density, and pressure. For the transient solver, these values define the state of the 
problem at the initial time step; for the stationary solver, they serve as a starting point 
for the nonlinear solver.

I N C I D E N T  M O L E C U L A R  F L U X

For each species, enter the Incident molecular flux, GG (SI unit: 1/(m2⋅s)).

P R E S S U R E

For each species, enter the Pressure, pG (SI unit: Pa).

For transient problems it is often difficult to specify consistent initial 
conditions. It is possible to add a stationary step in the study to serve as 
the initial condition for the transient problem, or to start the system at 
total vacuum (all values equal to zero) and to ramp up the pressure or flux 
at inlets or reservoirs prior to adding time-dependent effects.
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N U M B E R  D E N S I T Y

For each species, enter the Number density, nG (SI unit: 1/m3).

Wall

The Wall feature provides boundary conditions for modeling different kinds of solid 
surfaces within vacuum systems.

W A L L  T Y P E

Select Wall type: Wall (the default), Outgassing wall, Adsorption/desorption, or 
Deposition. For Wall it sets the incoming molecular flux for each species, G, equal to 
the flux emitted from the wall, J. Therefore all the incident molecules are diffusely 
reflected.

F L U X

For Outgassing wall it allows an additional outgassing flux J0,G to be added to the 
incident flux, so the total emitted flux for each species is given by J = G+J0,G. Select 
an Outgoing flux: Specify directly (the default), Number of SCCM units, Mass flux, Total 

mass flow, or Thermal desorption rate. 

Specify Directly
For Specify directly, and for each species, enter a value or expression for J0,G (SI unit: 
1/(m2⋅s)). 

Number of SCCM (Standard Cubic Centimeters Per Minute) Units
For Number of SCCM units, and for each species, enter Qsccm,G (dimensionless). This 
quantity is automatically converted to a standardized volumetric flow rate in SI units. 
Select an option from the Standard flow rate defined by list — Standard density (the 
default) or Standard pressure and temperature.

• For Standard density enter a Standard molar volume Vm (SI unit: m3/mol). The 
default is 0.0224136 m3/mol (in accordance with SEMI standard E12-0303).

• For Standard pressure and temperature enter a Standard pressure Pst (SI unit: Pa) and 
Standard temperature Tst (SI unit: K). For 2D components, also enter a Channel 

thickness dbc (SI unit: m).

Mass Flux
For Mass flux, and for each species, enter a value or expression for Mf,G (SI unit: 
kg/(m2⋅s)). The default is 0 kg/(m2⋅s).
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Total Mass Flow
For Total mass flow, and for each species, enter a value or expression for Qm,G 
(SI unit: kg/s). The default is 0 kg/s. For 2D components, also enter a Channel 

thickness dbc (SI unit: m). This is used to specify the depth of the boundary in the 
out-of-plane direction.

Thermal Desorption Rate
For Thermal desorption rate, and for each species, enter a value or expression for Dr,G 
(SI unit: W/m2). The default is 3e-12[torr*l/(cm^2*s)]. The outgassing flux, 
J0,G is related to the thermal desorption rate via J0,G = NADr,G/RT, where NA is 
Avogadro’s number, R is the universal gas constant, and T is the temperature.

A D S O R P T I O N / D E S O R P T I O N

For Adsorption/desorption it is used in transient models to model adsorption and 
desorption of gas molecules on the surface. For each of the species enter the following 
information.

• Sticking coefficient SG (dimensionless). This defines the probability that molecules 
incident on the surface are adsorbed.

• Desorption rate DG (SI unit: mol/(m2⋅s)). This defines the rate of desorption. The 
boundary condition tracks the number of moles of gas adsorbed per unit area of the 
surface (fmf.n_ads) as a function of time. 

• Initial adsorbent concentration nads,0,G (SI unit: mol/m2). 

• Additional molar flux ΓG (SI unit: mol/(m2⋅s)) can be added to the surface, enabling, 
for example, the modeling of molecules arriving at the surface by diffusion through 
the walls of the chamber from the outside (these molecules are added to the 
adsorbed molecules on the surface). Note that molar units are used for the adsorbed 
molecules, but the total number of molecules per unit area is available as the variable 
fmf.N_ads.

Solving for the absorbent concentration can cause convergence issues if 
the concentration is close to zero, as its value can sometimes go negative 
during the solution process. If this happens when using this boundary 
condition, tighten the relative solver tolerance (see the settings for the 
Study 1>Time-Dependent Solver node) to 1e-3. Then in the settings for the 
Study 1>Solver Configurations>Time-Dependent Solver node change the 
absolute tolerance to 1e-4 (if this node is not visible right-click the 
Study 1 node and select Show Default Solver).
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D E P O S I T I O N

Deposition is used for simulations in which the molecular flow of a deposited species is 
tracked. It is assumed that all the molecules arriving at the surface are deposited. 

For each species, enter a Film density ρfilm,G (SI unit: kg/m3) and Initial film 

thickness hfilm,0,G (SI unit: m) to compute the film thickness (fmf.h_film) as a 
function of time.

Diffuse Flux

The Diffuse Flux boundary condition sets the molecular flux emitted from the boundary 
to a user-specified value. The flux is emitted according to Knudsen’s law (the emitted 
flux in a given direction is proportional to the cosine of its angle to the surface normal). 
This can be set directly as a flux, as a total incoming mass flow, or number of SCCMs.

D I F F U S E  F L U X

Select the Outgoing flux: Specify directly (the default), Number of SCCM units, Mass flux, 
or Total mass flow. The rest of the settings are the same as for Wall, described in the 
Flux section.

Total Vacuum

Use the Total Vacuum boundary condition to set the flux emitted from the wall, J, 
equal to zero. This is equivalent to an opening to a large vessel or extended region with 
a much lower pressure than that in the system.

Reservoir

The Reservoir boundary condition computes the incoming molecular flux from a large 
adjacent vessel or region filled with gas at a specified number density or pressure. In 
this case the effusing flux obeys Knudsen’s law.

The reservoir boundary condition represents an opening to an adjacent chamber 
whose extent is much larger than the molecular mean free path. The boundary 
condition assumes that the molecules in the reservoir have a Maxwellian distribution 
of velocities and that the size of the opening to the reservoir is much less than the mean 

See also Adsorption and Desorption in the section Theory for the Free 
Molecular Flow Interface.
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free path. Molecules travel through the opening by a process known as molecular 
effusion. Effusion is a process that selects molecules with higher molecular speeds than 
average, because they are traveling towards the hole faster than the other molecules. 
Effusing molecules therefore have a larger average velocity than the molecules in the 
adjacent reservoir. As a result the pressure or number density at the reservoir boundary 
can differ from the value set in the boundary condition — which determines the 
pressure that would be measured within the reservoir away from the opening.

R E S E R V O I R

Select the Boundary condition: Reservoir pressure (the default) or Reservoir number 

density.

• For Reservoir pressure, and for each species, enter a value or expression for the 
Reservoir pressure p0, G (SI unit: Pa). The default is 0 Pa.

• For Reservoir number density, and for each species, enter the Reservoir number 

density n0, G (SI unit:1/m3). 

Vacuum Pump

Use the Vacuum Pump node to represent a vacuum pump such as a turbomolecular 
pump or a diffusion pump.

V A C U U M  P U M P

Select how to Specify pump flux: Fraction of incident molecules (the default), Directly, or 
Pump speed. The emitted flux J is given by J = G−Jpump. 

The Fraction of incident molecules fG, is specified either directly, or through a Pump 

speed, SG, such that f=√(2πMn/RT)S/A (here Mn is the molar mass of the species, R 
is the universal gas constant, T is the temperature, and A is the area of the pump). This 
condition applies pointwise across the surface of the pump.

• For Directly, and for each species, enter a value for Jpump,G (SI unit: mol/(m2⋅s)).

• For Fraction of incident molecules, and for each species, enter a value for fG 
(dimensionless). The default is 0.8.

• For Pump speed, and for each species, enter a value or expression for SG 
(SI unit: m3/s). The default is 500 l/s.

Care should be taken with the specification of Jpump,G to ensure that the 
value is never negative.
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For 2D components, also enter a Channel thickness dbc (SI unit: m). This specifies the 
out-of-plane thickness of the pump, which is required in order to compute its area.

Plane Symmetry

Use the Plane Symmetry node to specify boundaries which correspond to symmetry, 
i.e. boundaries where the incoming and outgoing fluxes are equal. Note that these 
boundaries must be planar and cannot be curved.
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Th eo r y  f o r  t h e  F r e e  Mo l e c u l a r  F l ow 
I n t e r f a c e

The Free Molecular Flow Interface theory is described in this section: 

• Solving the Flow

• Calculating the Particle Flux

• Calculating the Pressure

• Calculating the Number Density

• Calculating the Heat Flux

• About Boundary Conditions for Pressure and Number Density

• Adsorption and Desorption

• Evaporation

• References for the Free Molecular Flow Interface

Solving the Flow

For the Free Molecular Flow interface when the Knudsen number is much greater than 
1, collisions between gas molecules as they traverse the interior of a system can be 
ignored. There are two common approaches to solving the flow in this case: the Monte 
Carlo method (which computes the trajectories of large numbers of randomized 
particles through the system) and the angular coefficient method. COMSOL 
Multiphysics uses the angular coefficient method, which computes the molecular flow 
by summing the flux arriving at a surface from all other surfaces in its line of sight. The 
macroscopic variables in the vicinity of the surface can be derived from kinetic theory.

In many cases it is reasonable to assume that molecules are adsorbed and subsequently 
diffusely emitted from the surface (this is often referred to as total accommodation). 

Although COMSOL Multiphysics currently does not offer a physics 
interface for Monte Carlo modeling of Molecular Flows, it is possible to 
use the Particle Tracing interface for limited Monte-Carlo computations 
(this requires the Particle Tracing Module). The Molecular Flow Through 
an S-Bend shows how to do this.
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In this instance, the appropriate probability density functions for emission from a 
surface ρ (θ, c) (SI unit: m−1s), where θ is the angle to the normal (SI unit: rad) and c 
is the particle speed (SI unit: ms−1), have been derived from the laws of physical gas 
dynamics and verified by molecular dynamics simulations (Ref. 1). A complete 
derivation of the probability distribution function in 2D is given in this section.

T H E  C O S I N E  L A W

The distribution of angles of reflection follows Knudsen’s cosine law,

 (3-11)

for θ in the range (−π/2, π/2) for both cylindrical (2D) and polar (3D) coordinates. In 
3D the azimuthal angle φ is in the range (0, π).

T H E  M A X W E L L - B O L T Z M A N N  D I S T R I B U T I O N

In free space, the gas molecule velocity components follow the Maxwell-Boltzmann 
distribution,

where

• ci is the velocity component in the i direction ( ),

•  in 2D or  in 3D,

• kB = 1.3806488 × 10-23 J/K is the Boltzmann constant, and

• T is the temperature (SI unit: K).

P R O B A B I L I T Y  D I S T R I B U T I O N  F U N C T I O N  I N  2 D

Let cx and cy be the velocity components in the parallel and wall normal directions, 
respectively. The relationships between the velocity components in Cartesian and polar 
coordinates are

Due to symmetry considerations, the component of the reflected molecule velocity 
parallel to the wall follows a Gaussian distribution,
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 (3-12)

However, as shown in the following derivation, the interactions with the surface in the 
normal direction are not symmetric and do not follow a Gaussian distribution, so the 
probability distribution function of the molecule speed c differs from the usual 2D 
Maxwell distribution.

The Jacobian of transformation between Cartesian and polar coordinates in 2D is

 (3-13)

and therefore

The two random variables for the velocity components are assumed to be independent, 
so that the probability distribution functions can be expressed in the form

The normalization conditions on the probability distribution functions are thus

Applying Equation 3-13 to the normalization condition yields

Substituting Equation 3-12 into the modified normalization condition then yields
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The functional form of  that satisfies both the normalization requirement 
and the cosine law (Equation 3-11) is

or, in Cartesian coordinates,

 (3-14)

Combining Equation 3-12 and Equation 3-14 yields the probability distribution 
function of the speed c,

which is noticeably different from the Maxwell distribution in 2D, as shown in 
Figure 3-1.

Figure 3-1: Comparison of the speed distribution of diffusely emitted particles in 2D to the 
standard Maxwell distribution.
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S U M M A R Y  O F  P R O B A B I L I T Y  D I S T R I B U T I O N  F U N C T I O N S

Repeating the derivation of the previous section in 3D yields an analogous probability 
distribution function; as in 2D, the result is found to differ from the distribution 
function of c that would be obtained naively from the Maxwell-Boltzmann 
distribution. The results in both 2D and 3D are summarized below. The polar angle 
distribution always follows the cosine law,

The molecule speed follows one of the distributions

 (3-15)

based on space dimension. In 3D, the probability distribution function of the 
azimuthal angle φ is uniform over the interval (0, π).

Calculating the Particle Flux

The flux of molecules from x′ arriving at point x as shown in Figure 3-2 is derived.
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Figure 3-2: Diagram showing the contribution of the flux arriving at point x from point 
x′in 2 dimensions.

Let the total rate of emission of molecules per unit area at x′ be J′ (SI unit: 1/(m2·s)). 
In the steady state J′ is independent of time. Note that in practice, the molecules take 
a finite time to travel from x′ to x, but this is not accounted for in the calculations 
(which are consequently quasi-static). 

In 2D the flux of molecules with speeds between c′ and c′ + dc′ leaving x′ with angles 
between θ′ and θ′ + dθ′ is

In 3D the flux of molecules with speeds between c′ and c′ + dc′ leaving x′ with angles 
between θ′ and θ′ + dθ′ and ′ and ′ + d ′ is

In 2D, molecules leaving x′ at angles between θ′ and θ′ + dθ′ is spread over an area of 
rdθ′ in the plane with normal parallel to r at x. This plane is in turn projected onto an 
area

 

on the surface at x (see Figure 3-2). In 3D, molecules leaving x′ at angles between θ′ 
and θ′ + dθ′ and ′ and ′ + d ′ is spread over an area of

J'dl'ρ2D θ'( ) θ'd ρ2D c'( ) c'd⋅

φ φ φ

J'dS'ρ3D θ'( ) θ' θ' φ'ddsin ρ3D c'( ) c'd⋅

r θ'd( ) θcos( )⁄

φ φ φ
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in the plane with normal parallel to r at x giving a projected area of

The arriving flux per unit area at x from x′, dG (m−2s−1), is therefore:

 (3-16)

The total flux is therefore given by:

where the integral is over the path l′, or the surface S′ that includes all the surfaces in 
the line of sight of x.

By the definition of the probability distribution, both the integrals over c′ evaluate 
to 1. Substituting for ρ(θ′) the following equations are left:

 (3-17)

In the Free Molecular Flow interface, COMSOL Multiphysics computes the incident 
flux on the surfaces G as the dependent variable. The outgoing flux from a surface 
(usually specified in terms of G by the boundary condition) is also available as fmf.J.
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--------------------------------------- Sd

S
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Calculating the Pressure

The pressure acting on the surface at x can be calculated from the rate of change of 
momentum of molecules normal to the surface. For incoming molecules the molecules 
from x′ give the following contribution to the pressure on the surface:

Substituting for ρ (θ) and integrating gives the total contribution of incoming 
molecules to the pressure, pin (SI unit: Pa), at x:

From Equation 3-15 it is shown that:

 (3-18)

The computed incoming pressure contribution is available on surfaces as fmf.Pin.

The surface is also emitting molecules at a rate J (in most cases J = G, but in general 
this does not need to be the case — for example, the surface can be outgassing in 
addition to emitting the adsorbed molecules so that J = G + J out). The emitted 
molecules also have a normal momentum change that contributes to the pressure in 
the following manner:

Thus the total pressure contribution from emitted molecules, pout (SI unit: Pa), is:

pd 2D
in J' l'd ρ2D θ'( )m θ2cos c'ρ2D c'( ) c'd

r
------------------------------------------------------------------------------------=

pd 3D
in J' S'd ρ3D θ'( )m θ2cos c'ρ3D c'( ) c'd

r2
--------------------------------------------------------------------------------------=
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Substituting for the mean velocity (using Equation 3-18 with ) the equation 
obtained:

 (3-19)

where the same result holds in 2D and 3D. The outgoing pressure contribution is 
available in the Free Molecular Flow interface as fmf.Pout.

Finally the total pressure acting on the surface, p (SI unit: Pa), is given by:

This is computed in the physics interface as the dependent variable p.

Calculating the Number Density

The number density at the surface can also be calculated from a similar argument. 
Molecules arriving at x from x′ with speeds between c and c + dc make a contribution, 
dn, to the number density, n (SI unit: 1/m3), at the surface that is related to their flux 
at the surface, dG, by:

Following the same argument, the total incoming number density at x is given by:

 (3-20)

The means of inverse speed (calculated using Equation 3-15) are given by:
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 (3-21)

Note that the integrand in Equation 3-20 depends only on the emitted flux, the 
normal, and the molecular velocity at the emitting surface (and not on the orientation 
or properties of the wall where the flux is arriving). Equation 3-20 can therefore be 
used to compute the flux arriving at any point within the flow domain, in addition to 
the flux arriving at surfaces. This is the basis of the number density reconstruction 
features and the number density calculation operator, which can be used to calculate 
the number density within the domain. See Number Density Reconstruction in the 
previous section for further details on how to use these features.

Considering again the case of a surface in the model, the contribution to the outgoing 
number density at a given angle and speed the from the emitted molecules is:

so the total outgoing number density is given by:

Substituting for the mean inverse velocities (using Equation 3-21 with ) the 
equation obtained:
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The incoming number density is available as fmf.Nin.
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where the same result holds in 2D and 3D. The outgoing number density is available 
in the physics interface as fmf.Nout.

The total number density of the molecules near the surface is therefore:

This is computed in the physics interface as the dependent variable n.

Calculating the Heat Flux

To compute the incident heat flux on a surface it is necessary to sum the kinetic energy 
of the incident molecules. On average each molecule carries kinetic energy, qm, given 
by:

Equation 3-15 can be used to shown that:

 (3-22)

The total kinetic energy arriving at the surface is calculated by multiplying the total flux 
arriving from a given direction, multiplying this quantity by Equation 3-22, and then 
integrating over all directions. From Equation 3-17 the appropriate integral is given 
by:

The outgoing heat flux is simply:
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The incoming heat flux is available as fmf.Qin.
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The net heat flux removed from the gas is given by:

This is the heat flux that flows into the solid walls of the vacuum chamber.

About Boundary Conditions for Pressure and Number Density

Consider the molecules effused from an infinite half space filled with a gas of number 
density n through a small hole in the half space with diameter much less than the mean 
free path of the gas.

Within the gas the molecules are traveling in all directions on a unit sphere with equal 
probability. The probability of molecules striking the hole at angles between θ and θ + 
dθ to the normal of the bounding surface of the half space is proportional to the 
fraction of solid angle (or angle in 2D) that this angular range occupies. In 3D, as 
shown in Figure 3-3, the total solid angle corresponding to angles between θ and 
θ + dθ and  and  + d  is . In 2D the angle is simply dθ.
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The net heat flux is available as fmf.Qtot.
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Figure 3-3: Diagram illustrating the portion of solid angles occupied by particles 
approaching a surface at angles between θ and θ + dθ, and between  and  + d .

The probability of particles effusing at angles between θ and θ + dθ is therefore:

It is assumed that the molecules are in equilibrium, so their speeds are given by the 
corresponding Maxwell-Boltzmann distribution in 2D and 3D. Therefore:

If molecules are traveling toward the surface at velocity c, then a volume of gas Accosθ 
strikes area A in unit time. The effusing flux contribution is then nccosθ. The 
contribution to the total flux from molecules at angles between θ and θ + dθ with 
speeds c and c + dc is therefore:

φ φ φ

ρ2D
eff θ( )dθ 1

2π
------dθ=

ρ3D
eff θ( )dθdφ 1

4π
------ θ θ φddsin=

ρ2D
eff c( ) m

kbT
----------c mc2

2kBT
---------------–

 
 
 

exp=

ρ3D
eff c( ) 2

π
--- m

kbT
---------- 
  3 2⁄

c2 mc2

2kBT
---------------–

 
 
 

exp=
 3 :  R A R E F I E D  F L O W  I N T E R F A C E S



 (3-23)

Compare this expression to the outgoing flux from a wall, noting that the form of the 
velocity distribution functions is similar to those in Equation 3-15:

Therefore, treat the flux effusing into the domain from the half space as a boundary 
with a flux Jeff given by:

where the same result holds in 2D and 3D. Because the half space is infinite the 
pressure in this region can still be determined by the ideal gas law giving the following 
result for the flux at an external pressure, p:

Inverting this expression gives: 

which can be compared with Equation 3-19

The factor of two difference occurs because the incoming pressure contribution is 
calculated separately in the case of Equation 3-19.
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Adsorption and Desorption

There is considerable complexity in the detailed physics of gas adsorption and 
desorption (see Ref. 2). Some of this complexity is summarized in Figure 3-4a, which 
shows some of the processes involved in the adsorption and desorption of an imaginary 
diatomic molecule. Molecules incident on a wall of the vacuum system are either 
reflected or adsorbed. The sticking coefficient defines the probability that an incident 
molecule is adsorbed. The molecule is usually physically adsorbed initially, being 
bound to the surface by weak van der Waals interactions between the adsorbate and 
the atoms in the solid surface, or in the case of multiple physically adsorbed layers, 
between the adsorbate and the underlying layer of adsorbed molecules. Molecules 
adjacent to the surface can then dissociate and chemically adsorb on the metal surface 
of the chamber. The reverse processes: chemical desorption, followed by reassociation 
can increase the number of physically adsorbed molecules on the surface. These 
physically adsorbed molecules can dissociate from the surface and consequently 
contribute to the desorbed flux. In addition to these processes, gases can pass through 
the walls of a vacuum system by the process of diffusion. Depending on the method of 
manufacturing, a newly constructed vacuum system contains a certain amount of 
dissolved gas in its walls. Initially the concentration profile of the gases is probably 
uniform through the thickness of the wall. When the chamber is pumped out, over a 
long period of time this uniform concentration changes to a roughly linear profile with 
a high concentration on the outside and a low concentration on the inside. It takes 
some time for this concentration profile to develop and the process of reaching this 
point is frequently referred to as diffusion in the vacuum literature. Once an 
equilibrium profile is reached then a constant mass transport occurs along the 
concentration gradient. This is known as permeation (although the process itself is, of 
course, diffusive). Permeation needs to account for the adsorption of the molecules 
onto the exterior surfaces of the vacuum chamber and the desorption of the molecules 
from the interior of the chamber.
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Figure 3-4: (a) Processes involved in the adsorption of an imaginary diatomic molecule. 
It is difficult to obtain the details of the individual reaction processes involved in this 
process for particular molecules. (b) The Molecular Flow Module's simplified 
adsorption/desorption scheme. This scheme assumes that the molecule is adsorbed as a 
whole. Although this might not be physically what is happening, the effect of the dissociation 
can still be added to the model by appropriate modification of the sticking coefficient and 
the desorption rate.

Modeling the adsorption and desorption of molecules on the surface of a vacuum 
chamber at this level of detail is possible if the Free Molecular Flow interface is coupled 
with the Chemical Reaction Engineering Module’s Surface Reactions interface. 
However, in practice there is usually insufficient data available to fully characterize the 
reactions occurring on the surfaces of the chamber. Furthermore, the barriers to 
desorption of physically adsorbed species are small at room temperature, so physical 
adsorption has little effect on molecular transport in the vacuum system (Ref. 3). It is 
therefore usually appropriate to consider only chemical adsorption. Given these 
considerations, the Adsorption/Desorption feature considers only the chemical 
adsorption of the molecule as a whole (see Figure 3-4b). If the molecule dissociates on 
adsorption then it is still possible to use this mechanism for practical modeling, but 
allowance must be made for the fact that the boundary condition tracks the total 
number of moles of the original gas molecule that have been adsorbed (in the example 
of the diatomic molecule the number of moles of the adsorbed species is double this 
number). An additional source term for the number of adsorbed molecules can be used 
to include the effects of diffusion and permeation through the chamber walls. Very 
complex and realistic situations can be modeled with this approach.
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The adsorption/desorption boundary condition specifies outgoing flux and the 
number of adsorbed molecules in the following manner:

where J is the emitted molecular flux (SI unit: molecules/m2/s), S is the sticking 
coefficient, G is the incident molecular flux (SI unit: molecules/m2/s), NA is 
Avagadro’s number, nads is the number of adsorbed moles (SI unit: mol/m2), D is the 
desorption rate (SI unit: mol/m2/s), and Γ is the additional source term for the 
adsorbed molecules (SI unit: mol/m2/s). S, D, and Γ, along with an initial value for 
the number of adsorbed molecules (nads,0), are specified in the boundary condition. 
These values can be specified as arbitrary functions of the concentration of adsorbed 
species (fmf.n_ads) allowing for highly flexible modeling of the adsorption and 
desorption process.

Evaporation

The Evaporation boundary condition specifies the outgoing flux using the following 
expression:

where av is the evaporation coefficient (SI unit: dimensionless), pvap is the vapor 
pressure (SI unit: Pa), NA is Avagadro’s number, Mn is the molecular weight (SI unit: 
kg/mol), R is the universal gas constant (SI unit: J/(mol K)), and T is the surface 
temperature (SI unit: K).

References for the Free Molecular Flow Interface

1. F. Celestini and F. Mortessagne, “Cosine Law at the Atomic Scale: Toward Realistic 
Simulations of Knudsen Diffusion”, Phys. Rev. E, vol. 77, 021202, 2008.

2. J.M. Lafferty, Foundations of Vacuum Science and Technology, Wiley Interscience, 
1998.

3. J.F. O’Hanlon, A User’s Guide to Vacuum Technology, Wiley Interscience, 2003.
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G l o s s a r y
This Glossary of Terms contains finite element modeling terms specific to the 
Molecular Flow Module and its applications. For mathematical terms as well as 
geometry and CAD terms specific to the COMSOL Multiphysics® software and its 
documentation, see the glossary in the COMSOL Multiphysics Reference Manual. 
To find references in the documentation set where you can find more information 
about a given term, see the index.
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G l o s s a r y  o f  T e rm s
adsorption Attachment of a molecule or atom to a solid surface. Adsorption involves 
a chemical bond between the adsorbed species and the surface.

angular coefficient method A method for solving molecular flows that computes the 
total flux arriving at a point by integrating the flux arriving from all other surface 
elements visible from that point.

Boltzmann equation A partial differential equation that describes the evolution of the 
density and velocity distribution function for a gas in both space and time.

Boltzmann BGK equation A form of the Boltzmann equation with a simplified 
collision term involving a single relaxation time. The equation was introduced in a 
paper by Bhatnagar, Gross, and Krook.

continuum flow Fluid flow that is well described by approximating the liquid as a 
continuum with the Navier-Stokes equations.

desorption The release of a molecule or atom from a solid surface to which it was 
previously attached. Desorption involves breaking the chemical bond between the 
adsorbed species and the surface.

diffusion Transport of material resulting from the random motion of molecules in the 
presence of a concentration gradient. In the context of vacuum systems, this term can 
refer to the transient diffusive process that occurs when gas molecules within the walls 
of the system diffuse into the chamber after it is initially pumped down. Once a 
constant concentration gradient is present in the chamber walls, the diffusive transport 
through the walls is often referred to in the context of permeation.

discrete velocity method A kinetic method for solving the Boltzmann equation, 
usually with a simplified collision term (for example, the Boltzmann BGK equation). 
The method removes the velocity dependence of the distribution function by 
discretizing the velocity space and solving separate convection equations for each of 
the discrete velocities. These equations are coupled together by the scattering term.

DSMC method A kinetic method for solving the Boltzmann equation, which 
computes the trajectories of large numbers of randomized particles.
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effusion The process by which gas is transported through a hole that is small compared 
to the mean free path.

equilibrium function A function that describes the equilibrium concentration of 
molecules belonging to one of the discrete velocities used in the Lattice-Boltzmann 
method.

free molecular flow The flow of gas molecules through a geometry that is much 
smaller than the mean free path (Knudsen number, Kn>10). In the free molecular flow 
regime, the gas molecules collide with the walls of the geometry much more frequently 
than they collide with themselves.

Knudsen number A dimensionless number that provides a measure of how rarefied a 
gas flow is; in other words, it is the mean free path of the gas molecules compared to 
the length scale of the flow. The following equation defines the Knudsen number Kn 
where λ is the mean free path of the molecules and L is a length scale characteristic to 
the flow.

Knudsen layer A layer of rarefied fluid flow that occurs within a few mean free paths 
of the walls in a gas flow. The continuum Navier-Stokes equations break down in this 
layer.

Lattice-Boltzmann method A discrete velocity method which is optimized for near 
continuum flows.

permeation A three-step process in which gases, especially hydrogen, can enter a 
vacuum system from the outside. The gas first adsorbs on the outer surface of a vacuum 
system, then it diffuses through the walls of the vessel, and finally it desorbs from the 
interior wall of the system.

quadrature A term describing the set of discrete velocities employed in the 
Lattice-Boltzmann method.

SCCM Standard cubic centimeters per minute. A unit of flow in which the quantity of 
gas flowing is converted into a volumetric flow rate under standardized conditions.

Kn λ
L
----=
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slip flow Fluid flow that occurs when the Knudsen number, Kn, is in the range 
0.01<Kn<0.1. As a result of rarefaction effects in the Knudsen layer the no slip 
boundary condition fails. The flow outside the Knudsen layer can be represented by 
the continuum Navier-Stokes equations provided that an appropriate slip boundary 
condition is used for the fluid flow and the correct temperature jump boundary 
condition is applied at the interface.

sticking coefficient The probability that molecules incident on a surface are adsorbed.

transitional flow Fluid flow that occurs when the Knudsen number, Kn, is in the range 
0.1<Kn<10. In this regime, the flow is so rarefied that continuum equations break 
down completely. However, collisions between the molecules are still important so free 
molecular flow is not applicable.
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